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INTRODUCTION
NOTE: The Command & Conquer™ Generals World Builder tool is provided on an “as-is”
basis. It is not supported by Electronic Arts Technical Support. Please see the EA Tools End
User License on boot-up for details.

Welcome to Command & Conquer Generals World Builder. This development tool is used by Electronic Arts
designers to create single-player missions and multiplayer maps for Command & Conquer™ titles, and now it’s
available to you. The full-featured 3D environment gives you unprecedented visual controls and a wide array
of tools to get the details of your maps exactly as you want them. Building game maps is easier than ever, as
the World Builder’s suite of tools lets you rapidly prototype your creations and then jump directly into the
game to play them.

KEY FEATURES
✯ Step-by-step process to build multiplayer maps. Follow the steps listed in this document to get up to

speed building multiplayer maps (➤ p. 36) for up to eight players. With a few extra steps, you can turn
your finished multiplayer map into a Skirmish map (➤ p. 40).

✯ Designed like an art tool. The menus, tools, and their uses are derived from desktop art tools. If you’re
familiar with traditional art software programs, World Builder will feel very comfortable.

✯ What You See Is What You Get. Interact with your maps through the same engine as the game. Visual
toggles and camera options in World Builder allow you to position the camera anywhere over the map
and to view some or all of its components at any time.

✯ Urban objects and textures. The enormous library of 3D objects includes detailed touches to create
realistic cities from all over the world. You can build dense Asian cityscapes, Middle Eastern villages, or
modern American sprawl. Objects and textures are included for roads, highways, bridges, and railroads,
too.

✯ Many environmental settings. Use textures and settings to place your map in a wide range of geographic
locations at any time of day.

✯ Small output. Created maps are small enough to email to your Command & Conquer friends.
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BEFORE YOU BEGIN
✯ Prior to starting World Builder, set your display to 800 x 600 or higher in the Display control panel. For

information on how to set it, see your Windows® Help file.
To get up and running in World Builder, you should do the following:
✯ World Builder supports the use of dual monitors. You can design on one monitor and test your designs in

the game on the other one.
1. To create a new map, select NEW from the File menu. As you read through this document, you can test

out what you learn inside World Builder.
2. To get familiar with the components of a Command & Conquer Generals map, ➤ Elements of a Map on p. 8.
3. For explanations of the different elements of the desktop of World Builder, ➤ The Desktop on p. 10.
4. For explanations about the individual menu items and toolbar controls, ➤ Command Reference on p. 14.
5. Follow the step-by-step instructions to build your first multiplayer map. For more information, ➤ Eighteen

Steps to Creating a Multiplayer Map on p. 36. With a few more steps, you can turn your multiplayer map
into a Skirmish map. For more information, ➤ A Few Extra Steps for Skirmish Maps on p. 40.

❍ To learn more about how to build specific features in your maps, ➤ Tutorial: How To on p. 43.
6. After you feel comfortable building multiplayer maps, you may want to try to create single-player maps.

Since behaviors for CPU-controlled armies must be scripted, single-player maps are more difficult to
create. For more information, ➤ Building Single-Player Maps on p. 42.

CONVENTIONS OF THE TOOL
✯ Length and width distances are measured in feet. To assist in measurement, you can toggle display of the

map grid. Each square of the grid measures 10 scaled feet on a side.
❍ To toggle display of the map grid, select SHOW GRID from the View menu.
✯ The most commonly used tools are placed in the toolbar above the Work window. There are many more

editing, viewing, and global tools in the menu system. For more information, ➤ Command Reference on p.
14.

✯ Depending on the command or object that you have selected, a window appears to the right of the
Work window. Change the parameters in this window to alter the properties of the selected item or
items.

❍ To select an object on the map, left-click on it. To rotate that object, click and drag the pointer at the
end of the object’s icon.

❍ To dolly the camera, right-click and drag the mouse to the edge of the screen. Release the mouse-button
to stop the camera movement.

✯ If possible, use a mouse with a mouse wheel, which can be used to zoom and pivot the camera.
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BEGINNING MAP DESIGNERS
After installing World Builder and reading this Introduction, beginning map designers should read the Getting
Started (➤ p. 7) chapter to learn the basic elements of the application. In the Laying Out a Map (➤ p. 30)
chapter, some fundamental concepts in designing maps are presented.
Start building a very simple multiplayer map by following the Eighteen Steps to Creating a Multiplayer Map
(➤ p. 36). If you have questions during the process, you can refer to the Tutorial: How To (➤ p. 43) section,
which describes in simple steps how to build individual terrain, texture, and object features of a map.
✯ Skirmish maps are made by adding a few more things to a multiplayer map. If you design a good

multiplayer map, you can produce a good Skirmish map easily. For more information, ➤ A Few Extra Steps
for Skirmish Maps on p. 40.

When you have completed your map, be sure to test it in the game.
✯ Since you must script unit, team, and player strategies in single-player maps, they are more challenging

to create. It is recommended that you wait until you have some skill in creating multiplayer maps before
you start building single-player missions.

ADVANCED MAP DESIGNERS
World Builder is a graphical tool whose design is based on industry-standard graphics applications. If you are
familiar with common art packages, the tools of World Builder should be fairly intuitive.
As you learn, you may want to review the Command Reference (➤ p. 14) section, which outlines every toolbar
tool and menu item in some detail.
✯ It is highly recommended that all designers become familiar with the Eighteen Steps to Creating a Multiplayer

Map (➤ p. 36) and A Few Extra Steps for Skirmish Maps (➤ p. 40) materials. These sections present a
general, step-by-step approach to developing maps. When you’re ready to build the more complicated
maps for single-player games, ➤ Eighteen Steps to Creating a Multiplayer Map on p. 36.

Additionally, the Tutorial: How To (➤ p. 43) provides simple instructions for creating rudimentary features of
maps.
✯ For definitions of terminology used in World Builder, ➤ Glossary on p. 82.



GETTING STARTED
Because the tools of World Builder are easy to use, you can begin building usable, multiplayer maps
immediately. This chapter discusses how to develop multiplayer and single-player maps in World Builder.
✯ Since single-player maps require behavior scripting of CPU-controlled opposition, you should begin by

building multiplayer maps.
At the conclusion of this chapter, you should have enough information to begin development of your own
project and references to other parts of the documentation to explore topics in depth.
✯ Prior to starting World Builder, you should set your display to 800 x 600 or higher in the Display control

panel. For information on how to set it, see your Windows Help file.
❍ To start World Builder, double-click World Builder icon or use the Windows Start menu. The program

opens. To begin building a new map, select NEW from the File menu.

Note: World Builder requires significant computational and system resources to update the
map and your computer screen. If it seems that your computer is updating too slowly, you can
adjust the display settings in World Builder to improve performance. For more information, ➤
Improving Performance in World Builder on p. 81.

Each designer discovers his or her own strategy for designing in World Builder. Before you begin designing,
you must decide whether your map is a single-player mission or multiplayer/Skirmish design. Multiplayer
maps should be more open in design, while single-player maps can be more constrained to create a
satisfying flow to the game.
After answering the above question, consider the following ones. What is the basic shape of the map? Is
there a dominating terrain feature? Is there a slope to it? Where in the world is the map located? Where are
the best locations to build a base? These questions can affect the concept that you begin to implement. For
more information on beginning your designs, ➤ Laying Out a Map on p. 30.
✯ As you build your map, you are likely to need to reposition the camera and change the scale of the

display. For more information, ➤ Camera Settings on p. 11.
✯ When you want to test your work in the game, you can save your map for use in the game. For more

information, ➤ Making Maps Available to the Game on p. 13.
The following sections provide further details on getting started.
✯ Elements of a Map. Defines the basic components of a map.
✯ The Desktop. Describes the windows, tools, and status information that is displayed in the application

desktop.
✯ Working with Map Files. How to accomplish the basic tasks of loading, saving, erasing, and exporting

your work.
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ELEMENTS OF A MAP
All Command & Conquer maps are composed of three basic components: terrain, textures, and objects which
are generally developed in that order. Using the tools of World Builder, you can add, remove, raise, lower,
and shape the terrain to describe the land forms of your map. On top of the terrain, you layer textures that
give the appearance of grasslands, desert, snow, asphalt, or any other earthly surface. Finally, objects such
as military structures, neutral buildings, civilians, trees, and vehicles are placed around your map for
strategic purposes or for a natural appearance.

The table identifies the components of a map and provides basic definitions. Following the table, you can
read about the global parameters that you can set for your map.
✯ For more definitions, ➤ Glossary on p. 82.

Terrain Terrain is the mesh underneath the surface that describes the shape of
the hills and valleys of the map.  

Textures Textures cover the surface of the map and give the visual appearance of
the varying land forms.  

Military Structures Each side has structures with specific military purposes.  
Neutral Structures Neutral buildings on your map can add a strong sense of place and are

useful gameplay elements. They can be occupied, commandeered, or
just blown up.  

Infantry Each side has multiple types of foot soldier.  
Land Vehicles The land war is usually won with jeeps, tanks, troop carriers, and other

military vehicles.  
Aircraft The USA and China sides can develop air capabilities. Map designers

should not forget the gameplay effects of aircraft.  
Roads These visual effects of the urban landscape are actually objects. In the

game, they become textures.  
Bridges In almost any battle, a bridge becomes a key tactical objective. Bridges

can be destroyed and repaired at the end points. Taller bridges require
vulnerable support beams.  

Railroads Railroads are specialized road textures with supporting structures like
stations, crossings, and tunnels.  

Bodies of Water Lakes and rivers are combinations of specialized shapes and textures. No
land vehicle can cross a body of water.  

Ambient Sound You can apply ambient sound to areas of your map such as city streets,
markets, and farms. Sounds are placed like other objects. You should
have no more than three ambient sounds in any displayed map area.  

Neutral Structure
Aircraft

Infantry

Land Vehicle

Texture

Road

Lake 

Military Structure

Bridge

Railroad
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Trigger Areas You can define trigger areas as polygons to be referenced in scripts.
These areas are invisible to the user but visible to every unit in the game.
Through scripts, units can take actions based on activities inside and
outside of trigger areas.  

Waypoints A waypoint is a marker that you place on the map. Through scripts, you
can reference the waypoint as a location on the map. There are a
number of specially named waypoints, which are mentioned throughout
this document.  

Waypoint Paths A string of connected waypoints becomes a waypoint path, which can
be referenced through scripts. Units and teams of units can be
instructed to move along waypoint paths.  

Other Map Elements  World Builder comes with a full library of miscellaneous man-made and
natural objects to spice up your maps.

MAP ENVIRONMENTAL SETTINGS
Map Perimeter. Around the edge of your map, you need to define a map perimeter, which indicates the
edge of the map for AI-controlled objects.
❍ To set your map perimeter, click the Border tool in the toolbar. For more information, ➤ Border Tool on

p. 26.
Default Water Plane. If you scroll to the edge of a newly created map, you can see a blue rectangle. This
rectangle is the default water plane for your map. Use this water plane to shape the largest body of water on
your map, as its cost on system resources is low. For more information on creating bodies of water, ➤ Water
Tool on p. 23.

GLOBAL LIGHTING
After you establish the time of day in your map, you can tweak the global lighting for terrain and objects.
❍ To change your global lighting settings, select GLOBAL LIGHT OPTIONS from the Edit menu.
✯ Although they are expensive in terms of performance, you can create custom shadows over individual

objects. For more information, ➤ Edit Shadows on p. 17.
In the Global Light Options, you can modify the light source over the map.
✯ Ambient: Ambient light comes from no single source. Enter RGB values for the ambient lighting. The

new color is displayed in the square.
✯ Sun: Set the angle of the sun and its 360-degree location around the map. Changes to these positions

affect the lighting on the terrain. Set RGB values to change the color of the sun.
✯ Accent 1: Define an accent light source using the same controls as Sun placement. An accent is an

additional lighting source to highlight a specific area of the map.
✯ Accent 2: Define a second light accent source using the same controls as Sun placement.
✯ Lighting Applies To: Apply the lighting settings to selected elements of the map. In rare cases, you may

want to light the terrain and the objects differently for mood, but keep the position of the light source
consistent.

To restore defaults, click RESTORE TO DEFAULT. To close the Global Lighting Options window, click the X
in the corner.
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THE DESKTOP
Read this section to learn more about elements found on the desktop of the Command & Conquer Generals
World Builder.

✯ Work window – The main window in the application, the Work window is where all terrain, textures,
and objects are placed and manipulated.

✯ Toolbar – Across the top of the Work window, the most commonly used tools are available as clickable
icons. For more information, ➤ Toolbar on p. 22.

✯ Context windows – Depending on what tool is selected, a window appears in which you configure the
settings of the tool or the object that you are placing.

✯ Menus – From the menu system, you can select commands to edit and view your map or change the
textures and windows of it. For more information, ➤ Menus on p. 14.

✯ Status Bar – At the bottom of the screen, the Status Bar displays current cursor positional and color
information. For more information, ➤ Status Bar on p. 27.

✯ Layers List – You can organize objects into visual layers for display purposes. Layers are listed and
manipulated in the Layers List. For more information, ➤ Layers List on p. 27.

A NOTE ABOUT 3D DIRECTIONS
Movements in three-dimensional space can be described in three directions. Stand up from your computer.
Let’s call the position where you are located, “Point A.”
The X-direction refers to steps to the left or right of Point A.
The Y-direction refers to steps forward or backward of Point A.
The Z-direction refers to changes in elevation from Point A. From where you’re standing, movements in the
Z-direction require you to jump into the air or dig into the ground.
✯ As a convention, the direction towards the top of the screen when you first load a new map is

considered North.

MAP SETTINGS
Through the Map Settings window, you can name and describe your map, as well as set the time of day. The
name and description of your map appear in the game.
❍ To change your map settings, select EDIT MAP SETTINGS from the Edit menu. In the window, enter a

name and a description in the spaces provided. Select time of day settings from the drop-down. To
accept the changes, click OK.

Toolbar 

Object Properties
window

Work window

Menus

Layers window

Status Bar
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RESIZING YOUR MAP
To your map, you can add more space or subtract terrain to trim off the unused pieces. It’s best to resize
your map before you have added many objects or waypoints.
✯ You should have at least an extra 70 tiles (700 feet) on each side of your map as additional workspace.
❍ To resize your map, select RESIZE from the File menu. For more information on creating bodies of water,

➤ Resize Map on p. 15.

MAP GRID
You can toggle display of a grid to assist in the placement of objects and the measurement of distances
between them. The grid actually displays the 3D wireframe underlying the terrain that you shape.
❍ To toggle display of the 3D wireframe, select SHOW WIREFRAME 3D VIEW from the View menu.
❍ To force placed objects to align with the underlying grid, select SNAP TO GRID from the View menu.

Snapping to the grid facilitates placement, alignment, and spacing of objects.
For measurement of distances between objects, you can switch your view to a top-down orientation.
❍ To switch to a top-down view, select SHOW FROM TOP DOWN VIEW in the View menu.
✯ Each grid square is 10 scaled feet on a side. Distances can be measured by counting squares, or you can

move the cursor over the two points and compare the locations displayed in the Status Bar. A calculator
may help.

❍ To change the number of grid squares displayed on-screen at any time, select PARTIAL MAP SIZE from
the View menu. In the sub-menu, select the grid size to display.

CAMERA SETTINGS
You can place the camera over any location on the map and vary its pitch and distance from the terrain. For
more information on repositioning the camera, ➤ Mouse Functions below.
❍ To change the pitch of the camera, select CAMERA OPTIONS from the Edit menu. For more

information, ➤ Camera Options on p. 17.
❍ To look in a specific compass direction, use the directional icons in the toolbar. For more information, 

➤ Other Tools on p. 26.
✯ For information on changing the size of the Work window, ➤ Window Menu on p. 20.

VIEW TOGGLES
To simplify your view of the map and to improve performance in World Builder, you can toggle the display of
various elements on your map.
❍ To toggle display of map components, use the commands under the View menu. For more information,

➤ View Menu on p. 18.
✯ For more information on improving the performance of World Builder, ➤ Improving Performance in World

Builder on p. 81.

MOUSE FUNCTIONS
Your primary device for manipulating terrain and textures and placing objects is the mouse. By moving the
mouse, you move the cursor over the section of map displayed in the Work window. When using the mouse
in conjunction with its buttons, you change the view of the window over your map.
❍ To select an item, click the Select and Move tool in the toolbar. Then, move the mouse over the item and

click the left mouse button. To select multiple items, click and drag a selection rectangle over the desired
items. All items inside the rectangle are selected and can be manipulated together.

❍ To dolly the camera across the map, click the right mouse button and drag until you are over the desired
location.

If possible, use a mouse with a wheel device in World Builder. The wheel can be used to zoom in or out of the
map and to rotate the camera.
❍ To rotate the camera, click the mouse wheel (if available) and drag the mouse.
❍ To change the height of the camera, roll the mouse wheel (if available).



QUITTING THE PROGRAM
❍ To safely exit the program, select EXIT from the File menu.
✯ If prompted, save your work, or unsaved changes are be lost.

WORKING WITH MAP FILES
This section covers the basic file functions of making maps—from creating a new one to distributing a
completed one to your Command & Conquer Generals friends.

CREATING A NEW MAP
❍ To create a new map, select NEW from the File menu. In the dialog box, enter the X and Y size of the

map, as well as the initial height of the terrain. Click OK.

SAVING YOUR WORK
World Builder maps are stored as data, along with references to all of the art that they use. This storage
method means that completed maps are usually less than 1.5MB.
❍ To save your map, select SAVE from the File menu.
✯ The default directory for saved maps is inside your My Documents folder. You can choose to save in any

directory.
❍ To save a version under a different name or in a different location, select SAVE AS… from the File menu.

To save the maps so that it is usable in the game, click USER MAPS. Save the map in that directory.
✯ The Save As feature is useful if you are engaged in major changes to your map or if you want to

experiment without committing to the change.

LOADING A MAP
To load your map, you load World Builder file. These files end with the .MAP extension.
❍ To load a map, select OPEN from the File menu. Navigate to the folder where you saved your map.

Select the .MAP file and press OPEN. Your map opens.
World Builder files contain all of the data necessary to describe the contents of your map. They do not
contain the object and texture libraries; in a World Builder .MAP file, objects and textures are stored as
references to the libraries that are automatically loaded when you load the World Builder file.

EARLIER VERSIONS OF COMMAND & CONQUER
World Builder does not support the loading, saving, or design of maps from earlier Command & Conquer titles.
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ERASING YOUR WORK
In World Builder, a few mouse clicks can undo or erase your worst blunders.

UNDO/REDO
If you make a simple mistake, undo it.
❍ To undo the last action, select UNDO from the Edit menu, or press v + Z.
✯ The last 10 operations can be undone. Changes to your view of the map cannot be undone.
❍ To redo an undone action, select REDO from the Edit menu, or press q + v + Z.

DELETING OBJECTS
❍ To delete one or more objects, select the objects in the Work window. Then, press y.

DELETING TEXTURES
❍ To delete a texture, repaint it with a new one.
❍ To revert to the macrotexture, select the macrotexture with the Eyedropper (➤ Eyedropper on p. 24). You

can fill in a texture field using the Flood Fill tool (➤ Flood Fill on p. 24).

DELETING TERRAIN CHANGES
❍ To undo a terrain change after you have completed it, press v + Z.
❍ To flatten the terrain to height of the surrounding terrain, use the Height Brush tool, configured to the

base height of the terrain. For more information, ➤ Height Brush on p. 23.

DELETING MAPS FROM YOUR COMPUTER
❍ To delete a map from your computer, navigate the directory tree of your hard drive to the directory

where you have saved your maps. Your map and its support files are contained in a directory named for
the map. Click and drag the directory to the Recycling Bin on your Windows desktop.

MAKING MAPS AVAILABLE TO THE GAME
At any time, you can check out your map in the game.
❍ To load your map in the game, select JUMP TO GAME from the File menu, or press v + J.
For debugging purposes, you can dump all of the naming, positional and scripting information for the
objects in your map to a text file.
❍ To dump your map to a text file, select DUMP MAP TO FILE from the File menu.
You can share completed maps with friends by sending the file as an email attachment. A completed map
should be less than 1.5MB in size.
✯ In online multiplayer games, if the host selects a user-created map, that map is automatically transferred

from his computer to all of the players in the game. Single-player maps must be manually transferred to
other players.
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COMMAND REFERENCE
The Command Reference contains all of the menu and toolbar commands available from the desktop.
Additionally, you can learn more about useful displays such as the Layers List and the Object Properties
window.
✯ Menus can be accessed from the menu bar at the top of the screen.
✯ The toolbar appears on-screen, and its display can be toggled in the View menu. For more information,

➤ Toolbar on p. 22.
✯ The status bar appears along the bottom of the application window. For more information, ➤ Status Bar

on p. 27.
✯ The Layers List allows you to organize the elements of your map into visual layers whose display can be

toggled. For more information, ➤ Layers List on p. 27.
✯ The Object Properties window lists the properties for any selected object. For more information, 

➤ Object Properties on p. 28.

MENUS

FILE MENU
NEW
Create a new map. In the window, enter the dimensions, the basic height, and the background texture to be
applied.
Keyboard Shortcut: v + N
Suggested dimensions:
✯ Single-player: no larger than 350 x 350 tiles.
✯ 2-player: 250 x 250 tiles.
✯ 4- to 6-player: 350 x 350 tiles.
✯ 8-player: 450 x 450 tiles. If you’re creating a map over 400 x 400 tiles, you should have clear reasons to

do so. For online games, you may not be able to find seven other players that can play such a large map
effectively.

Suggested border:
✯ 70 tiles (700 feet) on each side.
Suggested initial height:
✯ 16, if terrain has very mild depressions. Use a setting of 50 if the terrain changes are more drastic.

OPEN
Open an existing map. In the dialog, navigate the directory tree to find the map. Then, click OPEN.
Keyboard Shortcut: v + O

CLOSE
Close World Builder and exit to the desktop. You are prompted to save any unsaved work.
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SAVE
Save changes made to an existing project. If the current project is new, then you must enter a filename.
Keyboard Shortcut: v + S

SAVE AS…
Save the current map under a new file name.

JUMP TO GAME
Save the current map, exit World Builder, and load the map in the game.
Keyboard Shortcut: v + J

NOTE: If your system is capable, you can have World Builder and the game open at the same
time and thus do not need to use this command.

RESIZE MAP
Add or subtract area on your map. In the window, the current size is displayed. Enter new dimensions for
your map. In the Anchor area, click the square where you want to locate the current map inside of the new
map. To resize the map, click OK.

NOTE: Resizing the map can change the location of waypoints, waypoint paths, and area
polygons. After resizing the map, double-check the location of all of the elements.

PRINT…
Print the current map.
Keyboard Shortcut: v + P

NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

PRINT PREVIEW
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Preview the printout of your map on-screen.

PRINT SETUP…
Windows-based print setup screen.

DUMP MAP TO FILE
Dump name, position, team, and scripting information of every object into a text file. The dumped file is
useful for debugging purposes. For example, you can search for objects or waypoints that you can’t find on-
screen in World Builder.

RECENT FILES
List the last four maps opened in the editor. To open a recent map file, select it in the menu.

EXIT
Quit World Builder. You are prompted to save any unsaved work.
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EDIT MENU
UNDO
Remove the last operation performed on your map.
✯ The last 10 operations can be undone. Changes to your view of the map cannot be undone.
Keyboard Shortcut: v + Z

REDO
Perform again the last map operation that was undone.
Keyboard Shortcut: q + v + Z

CUT
Remove all selected objects and place them on the clipboard.
Keyboard Shortcut: v + X

COPY
Duplicate all selected objects and place them on the clipboard.
Keyboard Shortcut: v + C

PASTE
Place the contents of the clipboard at the selected location.
Keyboard Shortcut: v + V

NOTE: Pasting objects can produce unexpected results. For more information, ➤ Select
Duplicate Objects below.

DELETE
Remove selected elements from the map.
Keyboard Shortcut: y

SELECT DUPLICATE OBJECTS
Select all objects that are located on top of another object. When you use the Paste command, objects are
pasted directly on top of the originals so that they look like a single item. You should periodically search for
duplicate objects.
✯ Don’t place objects on top of each other; use this feature often.

SELECT BAD TEAM OBJECTS
When a created team is deleted, any objects remaining on the map from that team have no team association
and can cause problems in the game. Periodically, use this feature to see if any objects have no team.

SELECT SIMILAR
NOTE: Pasting objects can produce unexpected results. For more information, ➤ Select
Duplicate Objects above.

When you select an object, the Select Similar command selects all objects of the same type on the map.
✯ Select Similar is most commonly used to change properties of object types.
Keyboard Shortcut: v + M
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SELECT MACROTEXTURE…
Note: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Select the background texture of the map.

REPLACE SELECTED…
Replace all instances of the selected object with another object. In the object library, navigate the object tree
to find the object to replace. To make the replacement, click OK.
✯ Object properties are inherited by the replacement objects.

PICK CONSTRAINT
When you choose a constraint, all selection tools in World Builder select only objects of that type. For
example, you can use Pick Constraint to click and drag a rectangle over an area to select all buildings in it.
❍ To return to the default selection mode, select ANYTHING from the Pick Constraint sub-menu.
✯ Use the keyboard shortcuts to pick constraints.

SCRIPTS…
Open the Scripts window (➤ Scripts on p. 61).

GLOBAL LIGHT OPTIONS…
Open the Global Lighting window (➤ Global Lighting on p. 9).

CAMERA OPTIONS…
You can set camera positioning for use during development. Use this information when developing cinematic
scripts.
❍ To set the angle of the camera, enter a new figure in the Pitch textbox.

EDIT SHADOWS…
Set the color (in RGB values) and the opacity of shadows on your map. Raising the default intensity creates
harsher shadows.

EDIT MAP SETTINGS…
Open the Map Settings window. Edit the name and description of the map that appear in the game. Select a
time of day. To apply the changes, click OK.

NOTE: When you change the time of day and conditions, you may have to re-texture some
elements and replace some objects with choices more appropriate for the new environment.

EDIT PLAYER LIST…
Open the Player List (➤ p. 55).

EDIT TEAMS…
Open the Teams window (➤ Building Teams on p. 56).



VIEW MENU
SHOW GRID
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Keyboard Shortcut: v + G

SHOW TEXTURE
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Keyboard Shortcut: v + T

SHOW TERRAIN
Toggle display of terrain changes on the map.

SHOW OBJECT ICONS
Toggle display of colored icons beneath objects to assist in selecting and manipulating them.
Keyboard Shortcut: v + B

SHOW WAYPOINTS
Toggle display of all waypoints.

SHOW TRIGGER AREAS
Toggle display of trigger areas created with the Polygon Tool (➤ p. 26).

SHOW SHADOWS
Toggle display of object shadows. Terrain shadows remain on and are determined by Global Lighting
(➤ p. 9) settings.
✯ Object shadows impact performance in World Builder, so leave them OFF if possible.

SHOW LABELS
Toggle display of identifying labels for sounds and waypoints.

SHOW OBJECTS
Toggle display of objects.

SHOW GARRISONED
Toggle display of flags over buildings controlled by a side.

SHOW MAP BOUNDARIES
Toggle display of the map perimeter.

SHOW SOUND FLAGS
Toggle display of flags used to indicate the position of ambient sounds.

SHOW IMPASSABLE AREAS
Toggle highlighting of areas that cannot be crossed by land vehicles. Use this toggle frequently during
development.
✯ Impassable areas should be identified with consistent texturing.
Keyboard Shortcut: v + I

IMPASSABLE AREA OPTIONS
In the window, you can enter, preview, and set the angle at which terrain becomes impassable.

EA TIP: You can set this tool at any angle to show slopes that are steeper than a desired angle.
You can highlight slopes too steep for vehicles to climb or imperfections in base areas and other
mesas. Use this tool in combination with the Smooth Height tool to polish your maps.
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❍ To change the angle of impassability, enter a number from 0 to 90 in the Angle textbox.
❍ To preview the effects, click PREVIEW. The changes are displayed in the map.
❍ To accept the changes, click OK. To cancel and exit without changing the angle, click CANCEL.

SHOW ALL OF 3D MAP
Toggle display of the entire map. Use this toggle to see how your work in a local area fits into the entire map.
✯ This feature can impact performance, so keep it OFF when you don’t need it.
Keyboard Shortcut: v + A

PARTIAL MAP SIZE
Change the displayed area of the map in the Work window to one of the available selections.
✯ If you are experiencing performance problems, keep this setting at the smallest grid size.

SHOW WIREFRAME 3D VIEW
Toggle display of the 3D wireframe that describes the terrain.
Keyboard Shortcut: v + W

SHOW FROM TOP DOWN VIEW
Toggle view of the map from a top-down perspective.

EA TIP: Use this feature with the 3D wireframe view to position objects and features relative
to each other. If Snap to Grid is ON, then you can use all three tools for careful placement and
alignment of buildings, roads, and sidewalks.

Keyboard Shortcut: v + F

SHOW 3-WAY BLENDS IN WHITE
When textures are blended with the Auto Edge Out (➤ p. 24) tool, more than two textures can be affected.
Three-way texture blends can cause performance slow-downs in the game, so you should try to find and
repair three-way blends. Limit their count to 300 in your map. For more information, ➤ Three-Way Blends on
p. 76.

SHOW CLOUDS
Toggle display of clouds. In World Builder, clouds pass in front of the light source off-screen to create the
sense of cloud cover. Showing clouds can affect performance in World Builder.
Keyboard Shortcut: v + U

SHOW SOFT WATER
Toggle display of a softer edge between water and land in World Builder. Turn it OFF to improve performance.

SHOW MACROTEXTURE
Toggle display of the background texture. Turn it off to improve performance.

CHANGE TIME OF DAY
Toggle between the four time of day settings: DAY, DUSK, NIGHT and DAWN. Each of the basic settings can
be tweaked with custom Global Lighting (➤ p. 9) settings.

NOTE: Not all objects can be used during settings such as night. If an object does not have a
“Night” image, it disappears from view yet still exists on the map. In the game, players may
crash into objects that they cannot see. If you switch the time of day in the middle of
development, be sure to double-check the existence of invisible objects.

Keyboard Shortcut: v + D

SNAP TO GRID
Toggle automatic snapping of any selected objects to align with the terrain mesh grid.
✯ Use this command when the 3D wireframe is visible. It’s very useful for city layouts, road layouts, and

sidewalks next to them.
Keyboard Shortcut: v + q + G
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SHOW BRUSH FEEDBACK
Toggle display of the texture or terrain brush passing over the map.

RELOAD TEXTURES
Terrain, object and texture manipulations can cause textures to disappear or to get scrambled. Select
RELOAD TEXTURES to reload the textures of your map.

TOOLBAR
Toggle display of the Toolbar (➤ p. 22). Some tools are available only through the toolbar.

STATUS BAR
Toggle display of the Status Bar (➤ p. 27) at the bottom of the screen.

LAYERS LIST
Toggle display of the Layers List (➤ p. 27) window.

WINDOW MENU
In the Window menu, you can set the resolution for the World Builder window.
✯ 800 x 600 is the default setting. Higher resolutions impact system performance.
❍ To reset the resolution and window positions to their default settings, select RESET WINDOW

POSITIONS.

TEXTURE SIZING MENU
MAP CLIFF TEXTURES
When textures are stretched across cliffs over 80 feet in height, they can look stretched. To do a special
mapping for a cliff surface, click the texture that is stretched, and then select this command. Textures are
shrunk to their maximum height without distortion, leaving black areas above and below, which you can fill
in with other textures.

REMOVE CLIFF TEXTURES
To remove all special texturing applied to cliffs, select this command.

EA TIP: If you have created a very tall cliff and cannot get textures to look nice on it, smooth
the cliff into multiple slopes using the Smooth Height tool.

OPTIMIZE TILE USAGE
During development, you may create two- and three-way blended textures. These can slow down your
machine. By optimizing textures, you allow World Builder to look at your blended textures to see if it can find
similarities between them. Similar blended textures are replaced by a single texture. Optimize tiles before
releasing a final version of your map.

REMAP TEXTURES…
Remap Textures lets you replace each texture of your map with a new selection. You may have to remap
textures if you change the time of day, geographic location, or conditions.
❍ To replace a texture, navigate the texture tree in the window to find a replacement and click OK.
❍ To skip that texture, click CANCEL. You can now choose to replace the next texture in your map.
✯ After you have remapped textures, you should check your blended textures again.
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TEXTURE SIZING INFO…
Display the amount of space and its percentage of the total available occupied by regular and blended
textures.
Each map can contain up to 4MB of texture space for regular and blended tiles. You are unlikely to reach
the maximum limit for blended textures, but you should check your usage for regular tiles.
✯ When you are selecting textures in the Terrain Materials Options window, a percentage is listed before

each texture name. This percentage indicates the amount of space for regular textures occupied by the
texture. Textures that have a 0% indicator are 128 x 128; although they repeat frequently, you are unlikely
to run out of space for them. The 4% textures occupy more space, repeat less frequently, and are
therefore more suitable for wide-open spaces on your map.

TILE 4 X 4
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Set the texture brush size to 4 tiles x 4 tiles.

TILE 6 X 6
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Set the texture brush size to 6 tiles x 6 tiles.

TILE 8 X 8
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Set the texture brush size to 8 tiles x 8 tiles.

VALIDATION MENU
GENERATE REPORT
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

FIX TEAMS
If you have units on your map that are not assigned to a team, you can use this command to place those
objects in the first team listed in the Teams window. However, it usually makes better sense to fix them
manually. For more information, ➤ Fixing Teams on p. 75.

HELP MENU
ABOUT WORLD BUILDER…
Learn more about World Builder.
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TOOLBAR
The most important tools for shaping the terrain, painting textures, placing objects, and adding waypoints
and trigger areas to your maps are located in the toolbar above the main application window for easy
access.
❍ To activate a tool, click its icon in the toolbar.
❍ To learn the name of a tool, move the mouse cursor over its icon in the toolbar.

FILE TOOLS
All of the File tools in the toolbar are available from the File menu as well.

EDIT TOOLS
Edit tools that are not available in the Edit menu are described below.

SELECT AND MOVE
The default tool, the Select and Move tool lets you select, adjust, and move objects. When using this tool,
each mouse button has a separate function. For more information, ➤ Mouse Functions on p. 11.

LOCK ANGLE
Toggle the locking angle for all selection and placement functions. When the angle is locked, all textures and
objects are angled in the same direction, which is useful for urban development.
✯ You can use the 3D wireframe of the terrain as a guide. For more information, ➤ Show Wireframe 3D View

on p. 19.

TERRAIN TOOLS

When shaping the terrain of your map, it is best to shape the largest elements first and then to work on the
finer details. The Terrain tools can scale to accomplish both tasks.
The Terrain tools in the toolbar allow you to raise, lower, and flatten terrain in large and small brushstrokes.
When you select a terrain tool, you can configure the settings of your brush in the Terrain Brush Options
window. With the Ramp tool, you can create pre-fabricated forms in the terrain with a smoothness and
finish that is difficult to achieve by hand.
✯ After manipulating terrain, double-check the placement of all objects located on the changed terrain.

Some objects do not conform to the terrain.
After you dig out an area, the Water tool lets you fill the area with water and give it a current like a river or
an undulating tide like a lake or sea.

New        Open        Save

Cut (➤ p. 16)    Copy (➤ p. 16)    Paste (➤ p. 16)    Print (➤ p. 15)    Select and Move    Lock Angle

Height Brush     Mound     Dig     Smooth Height     Mesh Mold Tool     Water Tool
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TERRAIN BRUSH OPTIONS
In the Terrain Brush Options window, you can configure the options for the terrain brush used in the Height
Brush, Mound, and Dig tools.
✯ Brush Width. The diameter in cells and feet that is affected by the Brush Height setting.
✯ Brush Feather Width. Distance beyond the center circle in which the changed terrain is blended into the

surrounding terrain.
✯ Brush Height. The height by which each application of the tool raises or lowers the terrain.

HEIGHT BRUSH
The Height Brush raises or lowers the selected terrain to the height defined in the window. Set the height,
width, and feathering circumference from the center point. Then, click on map locations to change the
height. The Height Brush is useful for building base areas, cities, and riverbeds.

MOUND
The Mound tool piles more terrain onto the selected location.

DIG
The Dig tool removes terrain from the map based on the settings in the Terrain Brush Options window.

SMOOTH HEIGHT
The Smooth Height tool smoothes the terrain between the edges of the terrain brush. Use the Smooth
Height tool to remove impassable areas and odd edges that can be created with the other terrain tools.
✯ Brush Width. Brush diameter in cells or feet.
✯ Filter Radius. The area beyond the brush width into which the tool attempts to smooth. Large values

create more smoothing and more dramatic effects.
✯ Feather Rate. The rate at which smoothing takes place. Low values require scrubbing with the tool over

an area to get the desired effect.

EA TIP: In many cases, the Feather Rate should be turned up to the highest settings.

MESH MOLD TOOL
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

Instead of forcing you to create common terrain shapes by hand each time, the Mesh Mold tool lets you
apply pre-defined shapes into the terrain. The Curved Ramp and Ramp options are useful for creating
inclines and declines suitable for roads.
✯ Scale %. Scales the mold applied to the terrain as a percentage of the displayed mold.
✯ Height. The elevation at the center point of the mold.
✯ Angle. The angle of the mold relative to the plane of the map.
✯ Adjust Heights. The Adjust Heights options let you adjust the heights of the surrounding terrain to meet

the terrain surface of the applied mesh mold.
✯ Preview. Check this box to see a preview of the mold applied to the terrain.
❍ To apply the defined mold to the terrain, click APPLY.

WATER TOOL
The Water tool lets you fill an area with water to create lakes and rivers.

EA TIP: Bodies of water can be very costly on system resources. Where possible, use the
default water plane that is part of any new map. For more information, ➤ New on p. 12.

✯ For more information on how to build lakes and rivers, ➤ How to Build a Lake on p. 52 or ➤ How to Build a
River on p. 53.



TEXTURE TOOLS
When painting textures, you should follow a large-to-small approach as you do for defining terrain. Start
with the Large Tile brush or Flood Fill tool to paint terrain over large areas that have few distinctive features.
Then, you can use the Single Tile tool to get to the nitty-gritty.
In the Terrain Material Options window, you can select the texture to apply. A sample is then displayed.
Behind it is displayed the texture that most closely blends the selected texture to the background
macrotexture.
❍ To paint a texture, select it in the texture tree. Then, click on the location in the map to paint. A texture

is painted.
✯ You can paint textures as passable or impassable for moving units. For more information, ➤ How to Paint

Passable and Impassable Terrain on p. 46.

SINGLE TILE
Switch brushes to painting textures on individual tiles.

LARGE TILE
Switch brushes to painting textures across multiple tiles. Large tile sizes are set in the Texture Sizing Menu
(➤ p. 20).

EYEDROPPER
❍ To select a texture already on the map, click the Eyedropper in the toolbar. Then, click the texture in the

map. You can now paint this texture with the other texture tools.
✯ You cannot select and apply blended textures. Use the source textures and recreate the blend.

FLOOD FILL
❍ To fill an area with a single texture, select the texture. Then, click the Flood Fill tool in the toolbar. Then,

click the area to fill.

AUTO EDGE OUT
This very important tool lets you blend one texture outward into the surrounding textures to create more
natural effects. The Auto Edge Out tool blends a selected texture outward and into the surrounding textures.
❍ To blend one texture into another, click the Auto Edge Out tool in the toolbar. Then, click the texture to

blend outward.

NOTE: In some cases, blending may not produce desirable results. You may have to repaint
initial textures again before you blend them. Do not apply blends on top of blends.

✯ It is possible to apply three-way blends, but they can impact performance in World Builder and the game.

AUTO EDGE IN
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

BLEND SINGLE EDGE
This tool lets you blend a single edge of a texture tile inward. Use it for detailed work towards the end of
your development process.
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Single Tile     Large Tile     Eyedropper     Flood Fill     Auto Edge Out     Auto Edge In;     Blend Single Edge



OBJECT TOOLS
The Object tools on the toolbar assist in the placement of single objects and sets of objects on your map.
Using the Place Object tool, you can place single object types one or more times on your map. For
specialized objects like roads, fences, and scorchmarks, individual tools let you get the right look. To place
natural-looking groves of trees, use the Grove tool.
In single-player maps, each CPU-controlled faction must be directed to build its structures in a specific order
through the Build List tool.

PLACE OBJECT
The Place Object tool is used to place any object in the library on your map. For more information, ➤ How
to Place Objects from the Object Library on p. 47.

ROAD
Roads, bridges, railroads, and sidewalks are specialized textures that you can paint on your map. To create
finished versions of these map elements, you should add other objects around them for polish.
✯ For more information, ➤ How to Build a Road on p. 49.

GROVE
The Grove tool can be used to create random, natural-looking groves of trees.
✯ For more information, ➤ How to Build a Grove of Trees on p. 52.

RAMP
Use the Ramp tool to place ramps in the terrain.
❍ To create a ramp, select the Ramp tool. Click and drag the length of the ramp in the map. In the Ramp

Options window, enter a width for the ramp. Then, click PLACE RAMP.
✯ For more information, ➤ How to Build a Ramp on p. 43.

FENCE
Use the Fence tool to place fences of all kinds. These fences lack defensive strength.
❍ For more information, ➤ How to Build a Fence on p. 49.

ADD SCORCHMARKS
The Add Scorchmarks tool lets you add scorchmarks to the terrain to create battlefield effects. You can
change the size and the type of scorchmark in the Scorch Options window.
❍ Like roads, scorchmarks are objects that get baked into the terrain during the game.

BUILD LIST TOOL
The Build List tool allows you to set the order in which CPU-controlled sides build their structures. For more
information, ➤ Build List on p. 59.
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Place Object     Road     Grove     Ramp     Add Scorchmarks     Fence     Build List
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LINE TOOLS

With the line tools, you can create waypoint paths for units to follow, trigger area polygons for use in
scripts, and the perimeter for your map.

WAYPOINT TOOL
The Waypoint tool lets you place single waypoints or waypoint paths for moving objects to follow.
❍ To place a set of waypoints, select the Waypoint tool. Click a location in the map, and the waypoint is

created. Drag to another location, and click again. A waypoint path joins the two waypoints. Continue
clicking and dragging until you create the waypoint path. In the Waypoint Path Label textbox, enter a
name for your waypoint path. You can enter multiple path names for the same set of waypoints as a
form of creating aliases.

❍ To rename a waypoint, select it. In the Waypoint Options window, enter a new name for the waypoint.
✯ Waypoints on the same waypoint path should have consistent names.

EA TIP: A single waypoint can be a useful bookmark or placeholder for unfinished work.
Looped sets of waypoints can be used to assign patrols to units.

POLYGON TOOL
The Polygon tool lets you define areas that can be used to trigger script actions. If you are planning to create
conditional events based on map locations, you must use the Polygon tool to define those locations.
❍ To create a polygon, click the Polygon tool. On the map, click the location for the initial corner. Click

and drag to other locations to define the corners and the perimeter of the polygon. In the Polygon
Options window, enter an appropriate name for the polygon.

✯ Scripts are used to control CPU-controlled units, teams, and players. For more information on scripts, ➤
Scripts on p. 61.

BORDER TOOL
The Border tool is used to define the perimeter of your map. Units and structures can operate only inside
the perimeter of the map.
Although the orange perimeter is always the default perimeter, you can create multiple perimeters, each of
which can be activated during the mission. Use multiple borders to open new areas of terrain as a reward
for the player accomplishing partial goals for the mission.
❍ To define the perimeter, select the Border Tool. In the map, click and drag any corner of the orange

perimeter to redefine the border.
✯ The lower-left corner of the perimeter is always fixed.

OTHER TOOLS

❍ To change the direction in which the camera is facing, click one of the directional icons in the toolbar.
❍ To open the Help file, click the Help icon in the toolbar.

Waypoint Tool     Polygon Tool     Border Tool

Look North     Look South     Look West     Look East     Open Help file
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STATUS BAR
OBJECT COUNT
The number of objects on your map. Try to keep it below 100 objects per player in multiplayer maps and
1,800 objects for single-player maps.

WAYPOINT COUNT
The number of waypoints on your map.

(X-COORDINATE, Y-COORDINATE)
The current X, Y coordinate of the cursor.

HEIGHT
The height of the terrain over which the cursor is located.

RGB COLOR VALUES
The RGB color values of the terrain over which the cursor is located.

LAYERS LIST

The Layers List window displays all map objects in layers. When an object is added to your map, it is placed
in the default layer. You can then create a new layer and move objects into it. The display of a created layer
can be toggled. Layers are a useful tool for visually sorting your map and hiding objects that don’t need to
be displayed in World Builder. Those objects do remain in your map and appear in the game.
❍ To toggle display of the Layers List, select LAYERS LIST from the View menu.
❍ To open the Layers List menu for any item, right-click on it.
The following commands are available in the Layers List menu.

INSERT NEW LAYER
Insert a new layer.

DELETE CURRENT LAYER
Delete the current layer without prompting.

MERGE OBJECT INTO
Merge the selected object into another layer.

MERGE VIEW SELECTION INTO
Merge multiple objects that have been selected into another layer.

SHOW/HIDE CURRENT LAYER
Toggle display of the current layer in the Work window.

Default layer

Created layer

An object
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OBJECT PROPERTIES
Whenever you select or place an object, the Object Properties window appears and lists the properties
assigned to that particular object.

NAME
An object’s name is used both in the game and in World Builder to identify the art asset.

TEAM
Identify the faction to which the object belongs.

SCRIPT
NOTE: This feature is disabled in the beta release of World Builder. It may be available in a
subsequent version.

INITIAL HEALTH %
Select the amount of health with which the object begins.
❍ To enter a custom health level, select OTHER from the drop-down list. In the adjacent box, enter the

percentage of health remaining.

MAX HIT POINTS
Select the maximum number of hit points available to the unit.
✯ It’s best to set custom values for hit points using the Initial Health % setting.

ENABLED
The object can move and respond to its environment.

POWERED
The object has power. Without power, an object does not animate and can do nothing.

INDESTRUCTIBLE
The object cannot be destroyed.

UNSELLABLE
The object cannot be sold.

SELECTABLE
The object can be selected.

AI RECRUITABLE
The object can be recruited by units on the same CPU-controlled side to execute scripted orders.

TARGETABLE
The object can be targeted by enemy units.
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AGGRESSIVENESS
Select an aggressiveness rating from the drop-down list.
❍ To put the object in sleep mode, select SLEEP. An object in sleep mode responds to movement orders

and nothing else. It is a good way to get units into a new position without allowing them to be
distracted by the environment.

EA TIP: Through scripts, changes to a unit or team’s aggressiveness are simple to do and
significant in effect. With an elevated aggressiveness, units appear to be executing a series of
commands. Yet, you did not have script them. It’s an inexpensive way to respond to the
player’s actions.

VETERANCY
Select a level of experience and ability for the unit from the drop-down list.
✯ The default setting is NORMAL, which means units have no experience.

WEATHER
In rare cases, you may want to change the weather and time around an object to get a better appearance.
To use weather effects other than those applied to the map as a whole, select an option from the drop-
down list.

TIME
To apply a different time of day to the object’s model, select from the drop-down list.

Z
Set the elevation of the object relative to the terrain (Z=0).

EA TIP: Negative values can bury the object for interesting visual effects. Be careful, though.
Additional terrain changes can bury the object entirely.

ANGLE
To change the angle of the object, enter a figure in the space provided. East = 0. Positive figures climb
towards North.

STOPPING DISTANCE
To change the stopping distance for moving vehicles, enter a new figure in the space provided.
✯ Changing the stopping distance is most useful for building cinematic scripts. For most map

development, use the default settings.

TARGETTING DISTANCE
Set the maximum distance at which the object can begin targeting other objects.

SHROUD CLEARING DISTANCE
Set the maximum distance that the object can peel back the black shroud to reveal what is underneath it.

PRE-BUILT UPGRADES
If the object already has upgrades when it is created, list them here.



LAYING OUT A MAP
The best Command & Conquer maps tell a story. Whether it is a single-player or multiplayer map, a good one
creates a sense of time and place, as well as establishing the nature of the gameplay. Based on the terrain
and resources on the map, savvy players immediately begin formulating their strategies, which in turn shapes
the struggle to win the campaign.
However, a good designer never takes control of the storytelling away from the player or players. In deciding
the layout of your map, you always want to create situations with open-ended possibilities. For example, a
good designer creates multiple entrances to a base area or critical piles of resources between two base areas.
✯ For ambitious designers who are creating multi-mission campaigns, it’s a good idea to have a sense of

the content of each mission and the shape of the story before you begin.
This chapter can provide some useful tips and issues to consider.

BASIC DESIGN DECISIONS
A good design is a delicate, yet flexible balance between a myriad of decisions. A good designer is always
looking ahead. To the degree that you can, make decisions at the beginning of your project about the
following issues.

SINGLE-PLAYER OR MULTIPLAYER
The first decision: Are you creating a single-player or multiplayer map?
✯ The third kind of map, a Skirmish map, is a multiplayer map with a few more elements. For more

information, ➤ A Few Extra Steps for Skirmish Maps on p. 40.
Successful designs for single-player and multiplayer missions vary greatly. A well-designed single-player map
applies escalating pressure on the player as the battle progresses, with satisfying results for conquering the
challenges.
✯ When scripting behavior for single-player missions, remember that you are not creating a fair system. You

are creating the perception of a fair one inside of a satisfying user experience. The difference is critical; if
you can create more interesting challenges by providing information to CPU-controlled sides through
scripting, do it. For more information on scripting, ➤ Scripts on p. 61.

Multiplayer maps are more open-ended. In a multiplayer map, you want each player to begin at relatively
equal strength in terms of map position, tactical advantages, and available resources. Consequently, maps
that favor an arena style of organization tend to create more interesting multiplayer missions.

DRAMA VS. REALISM
Before you begin to work on your map, you should make some essential decisions. Are you creating a
realistic simulation of a location in the world? Or, are you creating a fantasy environment? A realistic map
requires more detailed work in molding the terrain, choosing your textures, and placing objects. While it can
be a lot of fun to create, for example, battles in your hometown, you may find yourself spending significant
time looking at offline maps and photographs.
If you go for the dramatic approach, then you can focus on creating the most interesting gameplay for all
participants in your map.
Of course, the best maps blend drama and realism. It’s a good idea to have an impression of where your
map fits along the spectrum.

THINK SPACE
Many user-created maps reflect the creator’s preferred style of play. For beginning users and designers, that
style favors turtling up in a base to develop an overwhelming army to crush the opposition. To support this
style of play, designs tend to have only one way in and out of a base and are filled with objects. Lacking
open space and containing too many units, maps of this variety produce slow, drawn-out games that tend
to follow a predictable slugfest pattern. Try to keep plenty of open space in your map. Openness means
flexibility, and a good designer tries to accommodate multiple gaming styles in his creations. For more
information, ➤ Accommodating Varying Styles of Play on p. 33.
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NOTE: You cannot limit a start location to a particular army, so do not design start areas of
your map to be for the GLA only, for example.

✯ Don’t isolate bases from each other. Isolation inherently favors sides with air power, so the GLA is at an
immediate disadvantage on those maps.

GEOGRAPHIC LOCATION, AND TIME OF DAY
What time of day does the battle begin? Where is your map located in the world? Is it a desert environment?
Is it up in the mountains? How many trees do you want in your map?
Making decisions about the location and time of day at the beginning of development can impact the design
of your map. For example, if you’re placing it in wooded terrain, remember that trees are objects that can
impact performance. After you have decided the when, where, and what of your map, you should spend
some time in the object library and texture library assessing which elements are going to work for your map.
For more information, ➤ Object Library on p. 47.

DEGREE OF DIFFICULTY
Particularly for single-player missions, the degree of difficulty is an important consideration and covers many
aspects of design.
Do the challenges grow as the player expands his control towards CPU-controlled locations? And finally, do
you want the player to be able to have a different experience depending on the Normal, Hard, or Brutal
difficulty setting that he selects in the game?

EA TIP: In general, the approach to difficulty ramping based on user-controlled settings is to
create the map under either the easiest or the hardest setting. Then, you can scale up or back
in units, structures, and behaviors for the other settings. For more information, 
➤ Ramping Difficulty on p. 63.

Degree of difficulty also covers design elements that have nothing to do with hostile opposition. For
example, if the base area closest to a player’s start location is very small, then the player must fortify that
location and expand into new territory early in the game. His forces are extended, making him more
vulnerable.

OTHER DIFFICULTY FACTORS
✯ Are players able to begin building full bases easily? Most designs provide a supply depot close to the

user’s start point, but interesting possibilities are available if the user enters the map with a strike force
that he must use to find supplies and start a base at some distance from his start point. Note that
collection units cannot automatically collect supplies from depots far from the base; the player must
direct them to the location.

✯ How hard is it to find additional resources? You can increase the challenge by placing supply depots
close to or far from a player’s start point. If one player must travel significant distance to reach a supply
depot while another has two depots close to his start location, the first player faces a greater challenge.

✯ How many entrances are there for each base location? While each base entrance should have at least
three entrances to it, you can create a different kind of challenge by having only one entrance to an area
that is sunken below the surrounding terrain. So, while the player can defend the entrances to his base
easily, it is important for him to gain control of the terrain above his base location.

✯ What are the terrain advantages? Are there terrain disadvantages? Is the shortest route to the enemy’s
base fraught with peril? Will the successful general drive a blitzkrieg force through a terrain disadvantage,
or should he circumnavigate the danger area with a much larger, occupying force? The best maps, of
course, allow all of these possibilities and more.

✯ Are there bridges? A bridge in a well-designed map offers a tactical advantage for the team that can
control it, yet the advantage should be counterbalanced by the difficulty of defending the bridge. Never
let a bridge be the only path between two areas of the map.

In multiplayer missions, the degree of difficulty is a factor, yet you should tend towards keeping the map
open, even, and conducive to combat.
While you may not have answers to all of the above questions, it’s important that you know what you don’t
know. It’s reasonable to postpone resolution until you’re actually shaping the map with the tools. However,
you should be aware that making large-scale changes can take a long time when you are far into
development.
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EA TIP: If you have yet to resolve some of these fundamental issues, you should try to figure
them out as soon as possible. Alternatively, you can regularly use the SAVE AS… feature to
save copies of your map.

MAKE A SKETCH
Whether you do it by hand or in an art application, create a sketch of your map before you begin. While
your final map is likely to change significantly from an initial sketch, it does give you a clearer view of the
relative positions of large features on your map and the space that you need to create them.
✯ You should also write on your sketch major design decisions such time of day, geographic location,

mission objective, and story synopsis (if applicable).

EA TIP: When planning your map on paper, use graph paper. You can scale each cell to a
number of World Builder units, following the suggested map sizes. For more information, ➤ New
on p. 12.

✯ For a good example of an initial sketch prepared in an art tool, ➤ Appendix A: A Good Initial Sketch on p. 85.

MAP DESIGN ISSUES
In very rough-cut form, plan your entire map before you begin. Keep in mind the following concerns:
✯ How big is the entire land plot on which the map sits?

EA TIP: Whatever you need to design a map, add 70 tiles (700 feet) in all directions. You can
always trim back at a later time. You can also reposition your map on the land plot.

✯ How does the map fit into the topography of the surrounding terrain? Is there a general slope to it?
Does it have large terrain features?

✯ How are the base areas positioned throughout the map? How are they placed relative to each other?
How big are they?

✯ Have you identified north on your map? In World Builder, the north direction defaults to the top of the
screen.

✯ What are the unique features, terrain or otherwise, of your map?
While you should develop your map on graph paper first, you may find it easier and faster to prototype in
World Builder. You can turn on the map grid to overlay a grid for alignment and measurement purposes.

GAME BALANCE: THE FUN FACTOR
Whether you’re creating a single-player or a multiplayer map, it’s important to make sure that each army has
a fair shot to win the game. When you’re developing maps, remember the following tips to ensure that you
create a fun map for everyone to play:
✯ Each map requires significant playtesting to make it a fun engagement. No one gets it right the first time.

Try to develop a group of designers with whom you can share and playtest your designs. If you’re doing
your own playtesting, try to check all base areas under all types of army.

✯ In a multiplayer map, create open spaces between base areas where opposing sides can fight. Open
spaces allow players to engage in battles of varying sizes. They are also hard to control, so an open area
can switch hands several times during a game.

✯ Between base areas of a multiplayer map, you can also create strategically significant areas such as
towns, cities, bridges, and resources such as oil derricks, refineries, and hospitals. It is critical to create
combat zones in multiplayer maps.
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ACCOMMODATING VARYING STYLES OF PLAY
In addition to getting feedback on bugs and overall quality in your map, playtesting with other people lets
you see how your map might be played by players with different gaming styles. It’s important to avoid
forcing players to win a game with only one playing style. You also do not want to allow players to win by
relying on a single gaming style. The following is a short list of some of the more common playing styles and
how they can be accommodated and limited in your maps:
✯ The Air Cavalry. Some players rely heavily on air power to attack the enemy and defend their positions.

Since air power is unavailable to the GLA, you should have AI-controlled GLA sides build Stinger sites
early in a single-player game. For multiplayer maps, open space and buildings that can be re-enforced
with anti-air infantry can effectively limit air power. One of the most effective tactics for the Air Cav types
is to drop units at the back of an enemy’s base, so be sure to leave a little space behind each base area
to mount a surprise attack.

✯ The Early Rushers. Some players attack as soon as they possibly can. While you want to encourage
combat, it isn’t fun for other players if they get wiped out in the first two minutes. A choke point can
limit Early Rushers, and multiple openings to each base area allows for effective counter-attacks.

✯ The Turtlers. New players in particular tend to hunker down in their base areas and build and build
their bases and units. In all maps, it’s good to have some worthwhile resources, such as strategic
buildings, supply depots or oil derricks near each base area. These resources provide incentives for the
Turtlers to expand out of their base areas. In single-player maps, an early attack from AI-controlled sides
can rattle a Turtler’s shell.

✯ The Nukers. A subset of the Turtlers, some players wait and wait until they can build and deploy their
super weapons. These players tend to avoid combat, which makes for dull games for the other players.
Again, base areas with multiple access points are harder to defend. For China and USA sides, their super
weapons require a great deal of power, so in single-player games, you can script strikes on their power
plants when these sides approach super weapon capability.

✯ The Road Graders. Some players prefer to build a massive mechanized army to crush the opposition.
These players slowly and steadily build an army of tanks, which can clutter the board and slow down the
game. While open spaces can encourage mighty battles, you as a designer can limit the scope of them by
creating a variety of smaller objectives that cannot be won as easily with a huge army. For example,
scattering resource depots on the map splinters an army. Additionally, strategically placed choke points
can slow the progress of a large army, giving defenders a chance to thin the herd. In single-player games,
regular attacks by AI-controlled sides can slow down the build-up.

✯ The Commandos. Particularly for fans of the GLA, the strike-and-move method of attack is appealing.
To assist the Commando types, you can create strategically advantageous positions on your map from
which to launch attacks. Buildings that can be garrisoned provide a great opportunity for a small force
to effectively thwart a larger one. Also, units on higher terrain have a longer range of attack than the
units on lower terrain, so it’s never a bad idea to have ridges overlooking base areas. Multiple entries and
space at the back of a base area allow for Commandos to make their mark. Commandos, however, are
vulnerable to air attack and can be easily defeated at choke points. You certainly want to reward players
that find clever and sneaky ways to bring a small strike force to bear against a larger and more powerful
enemy.

When you are planning out your map, you may want to examine it from the perspective of all of these types
of players. How would a Commando-style player approach each base area? Are there possibilities for the
Road Grader to enjoy this map? While it’s impossible to please every player and style, considering each style
often illuminates mistakes and leads you to simpler and more effective ways to build a better map.
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LAYOUT DO’S AND DON’TS
The previous section alludes to a number of the critical design considerations for any map. Whether it is a
single-player, multiplayer, or Skirmish map, the following Do’s and Don’ts apply.

DON’T
✯ Don’t litter the map with sources of money. For good balance, each player should have access to

$40,000 to $60,000 with comparatively the same difficulty in gaining and holding the resources. Be
careful in the number of oil derricks that you leave on the map, as these permanent sources of funds can
affect the balance of play at the end of a game. In general, too much money on a map results in massive
slugfests that can take a long time to play and can slow frame rate in the process.

✯ Don’t confine yourself to the rectangular or symmetrical map. Although the map perimeter is defined
with a rectangle, you can build impassable terrain such as mountains or bodies of water along the edges
to reshape the playable area of your map. Additionally, you can script changes in the active map
perimeter, effectively opening new terrain. While maps of differing sizes, shapes, and symmetries do limit
the possibilities, they can be a lot of fun to play.

✯ Don’t put larger buildings and objects in the front and center of your maps. While players can rotate the
camera, they tend to keep it in the standard view. So, objects that you place behind these larger objects
can get hidden. Place large objects towards the rear and the extremities of the map.

✯ Don’t become infatuated with choke points. It’s easy to fall into the trap of creating choke points where
a few units can hold off a whole army. If you have too many choke points, the game can be slowed
down too much. It’s probably a good idea to have, at most, one choke point per base. When you do
create a choke point, it should be as wide as least five tank lengths at a minimum.

✯ Don’t isolate bases. Don’t make them difficult to access either through protection by natural resources,
hiding them behind a maze of mountains, or on islands. The GLA, in particular, needs room to
maneuver.

✯ Don’t make the only access to a base area over a bridge. It sounds like a fun idea to make the Bridge
Over the River Kwai, but such maps make for bad games. Bridges are frustrating attack routes and
usually offer advantages to the defenders. If a bridge is a set piece to your map, make sure that there’s at
least one other way to cross the gap.

✯ Don’t build King of the Hill maps. If you create one base area in the middle, then that army must fight
all of the others. If that general is successful, then everyone else is frustrated. Either have all of the base
areas in the middle or all of them on the perimeter.

✯ Don’t overlap textures. Choose a good macrotexture, and build your texture fields so that they do not
overlap. It’s very easy to create long seams of three-way blended textures by overlapping. You can create
nice effects without the overlap.

✯ Don’t use massive objects like the Fortress Wall or a Dam in your maps often. If you must, make them
Indestructible and Unselectable.

✯ Don’t build lots of flowing rivers. Flowing rivers are expensive in terms of system resources. Instead, try
to build rivers that cut into the map and then cut back out.

✯ Don’t go crazy building fences. Each individual unit in a shrub fence, for example, is an object. A long
string of fences of this type is a big hit on system resources.

✯ Don’t build mazes in your maps. It causes problems for pathfinding units and slows down the game.
Generally, maze maps aren’t much fun either.
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DO
✯ Do utilize space. Space, space, and more space. Create plenty of open space in your maps. You should

physically lay out a base at the start points to provide ample room for the player or AI.
✯ Do choose a theme for your map and stick with it. Maps that change direction in the middle of

development are easy to spot. Choose a climate, time of day, and a location (urban or rural) for your
map. You can combine some of these elements; a number of good maps have been placed at the edge of
a big city. Make a choice and stick to it; write down your commitments so that you don’t forget them.

✯ Do build large areas for your bases. A rule of thumb that some designers have used is to make a base
area the size of 5 x 5 Command Centers. Since they are the largest structures in the game, airfields can
be useful in measuring out space for a base area.

✯ Do build space at the back of each base area where troops can be dropped for surprise attacks. Most
players build their initial defenses to face the opposition and rarely consider the back of the base. Later
in the game, as the conflicts have heightened, a well-timed attack by infantry units from the back can do
serious damage, change the balance of the game, and make it more enjoyable (for everyone else).

✯ Do create open space between base areas in a multiplayer map. These areas become combat zones that
often determine who controls which areas of the map. The early and middle games are all about control
of the map, so create the spaces where these battles can be resolved.

✯ Even in an urban setting, create as much space as possible. Units can have a hard time finding paths
through urban environments if they are too congested. The rule of thumb is to have at least five tank
lengths of width for any choke point.

✯ Do check to make sure that there are at least three ways to access each base area. There should be two
direct routes, and a third indirect route. Each entrance should be some distance from the other routes.
In single-player games, an effective scripting technique is to have the initial attack come from the front
for Normal and Hard difficulty and to have the first hit to come from the tertiary route on Brutal
difficulty.

✯ Do create a palette of textures in use. As you use a new texture, it’s a good idea to paint a small swatch
of the texture outside the map perimeter. You can use the swatch to quickly select the texture and to
track the number of textures in use on your map.

✯ Do give cliffs their own unique texture. It helps to identify them for the player who may be looking ahead
to plan routes into the enemy’s base, only to discover there’s a “hidden” cliff in the way. It is critical to
visually identify impassable areas like cliffs with artwork that is unique from playable terrain.

✯ Do build visual set pieces such as farms, oases, town squares, and the like. These set pieces give a real
sense of place and add a lot to the atmosphere. Many user-created maps neglect these elements, and
their maps look like arenas instead of environments. To build good-looking set pieces, determine the
geographic setting for your map, build one set piece with which you are satisfied, and then add the other
ones through copy, paste, and edit. If the set piece has no strategic value to the map, keep it small: no
more than six objects.

✯ Do limit yourself to about 100 objects per player in a multiplayer map. Use your props wisely.



EIGHTEEN STEPS TO
CREATING A
MULTIPLAYER MAP
World Builder is a deep and sophisticated tool that you can use to create dynamic multiplayer maps. While
our in-house designers have been using and perfecting this tool for years, you can begin right away to create
exciting maps of your own by following these eighteen steps.
✯ Skirmish maps are created from completed multiplayer maps. By adding a few elements to your finished

multiplayer map, you can create a good Skirmish map. For more information, ➤ A Few Extra Steps for
Skirmish Maps on p. 40.

CARDINAL RULES FOR MULTIPLAYER MAPS
✯ Space is key. Make as much space as possible between base areas and in the base areas. Lacking

sufficient space, the Skirmish AI can place buildings in odd places.
✯ For each player, try to make $60,000 in resources, which is two supply piles of standard size. A single oil

derrick is an optional addition, and, if used, it should be a goal to reach near the player’s base.
Refineries tend to be destroyed if they are captured by a side.

✯ Avoid using lots of civilians in multiplayer maps. They slow frame rate and get in the way of the fun. If
you must use them, do so in limited numbers. A total of six civilians on a looping waypoint path is
usually sufficient.

✯ Maximum multiplayer map sizes. While it’s possible to exceed these map sizes, you should have good
reasons to do so. For two-player maps, the max size should be 250 x 250 tiles. For four to six players,
350 x 350. Eight player maps should not exceed 450 x 450. If you make a map larger than 400 x 400,
you should have a clear reason for doing so.

✯ Keep 70 tiles (700 feet) of space beyond the map perimeter on each side of your map. This overflow area
serves as a staging area and a workspace for terrain features that flow into the map.

EIGHTEEN STEPS FOR MULTIPLAYER MAPS
✯ During the course of development, you may discover problems with your map that defy resolution. For

more information, ➤ Debugging on p. 75.
1. Decide the map layout. Before you begin, you should have a good idea of what you’re trying to develop

in your map. What will it look like? What is the basic topography? Are there any distinctive features to
the map? Is there a general slope to the map? Is it in an arid climate? Or is there snow on the ground?
What time of day will the battle take place? How many sides will participate? A design decision is a
commitment, and making more decisions at the beginning of development can streamline the process of
finishing the map. For more information, ➤ Laying Out a Map on p. 30.

✯ You should have a good idea of the design unknowns, too. Try to resolve them as soon as you can during
development. Use the SAVE AS… feature to experiment with those unknowns.

✯ For information on changing the settings for your map, ➤ Map Environmental Settings on p. 9 and ➤ Map
Settings on p. 10.

✯ You can change the background texture of your map using the Flood Fill tool. For more information, 
➤ Flood Fill on p. 24.

2. Prototype your map. When you’re deciding your layout, you may choose to sketch your ideas on paper.
To flesh out your ideas in the map, follow a top-down approach. Figure out the largest features of the
map, such as lakes, mountain ranges, valleys, cities, and rivers. Also, you should have a basic idea of
where you want the various sides to build their bases. Decide their location and begin using the tools in
the order described in the following steps.

✯ For a good example of an initial sketch prepared in an art tool, ➤ Appendix A: A Good Initial Sketch on p. 85.

EA TIP: You can essentially create a graph paper overlay for your map. In the View menu,
turn ON Show Wireframe 3D View and Show from Top Down View. The displayed squares are
10 scaled feet on each side.
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✯ Units that come to the edge of your map can, in some cases, exit the map. To prevent such exits, create
impassable terrain on the perimeter or paint impassable textures to prevent passage. For more
information, ➤ How to Paint Passable and Impassable Terrain on p. 46.

✯ Build large areas for your bases. A rule of thumb that some designers have used is to make a base area
the size of 5 x 5 Command Centers. Remember to consider that the USA and China may have to place
airfields, the largest structures in the game, so check them, as well.

3. Set waypoints. It’s a good idea to mark the locations of bases and resource depots early in the map
development process. Since users cannot erect buildings on uneven terrain, you should identify these
locations as soon as you can.

✯ Add waypoints for important features such as bridges, railroads, roads, and cities. Of critical gameplay
value are the locations of resource depots, oil derricks, and crates.

❍ To set a waypoint in your map, click the Waypoint tool in the toolbar. In the Waypoint Options window,
enter a name for your waypoint.

NOTE: If you are creating waypoints to identify where players are going to begin in a
multiplayer map, the names must follow a specific format. For example, “PLAYER_1_START”
is always the starting location for Player 1. For each player in a multiplayer map, you must
also create a player in the Player List. For more information, ➤ Player List on p. 55.

4. Build the basic terrain. The Height Brush tool lets you flatten areas to the same elevation. Using the
Mound and Dig tools, you can shape the terrain. As you move the mouse back and forth over an area,
you begin piling (or digging) more terrain on the map. At this point, you just want to create the basic
features in their approximate locations at relative heights to each other. For more information, ➤ Smooth
Height on p. 23.

❍ To view the underlying mesh of the terrain, select SHOW WIREFRAME 3D VIEW from the View menu.
❍ To view the entire map, select SHOW ALL OF 3D MAP from the View menu.

EA TIP: The entrances and exits of each base area are very important for gameplay. Each
base should have at least three entrances to it. Fewer entrances allow users to fortify their
bases too easily. Also, don’t create choke points that are tighter than five tanks across, or you
may experience pathfinding problems for your units.

✯ If you’re going to add bodies of water, make sure that you reserve space in your map for them.
5. Check the size. Now that you have created the basic terrain and the locations of your major gameplay

elements, is the map big enough to contain everything? Remember that you have to add extra workspace
to your map and should create impassable terrain at the edge. So, adjust your map size accordingly.

❍ To resize a map, select RESIZE under the File menu. For more information, ➤ Resize Map on p. 15.
6. Build the terrain in detail. You’re now ready to get the terrain just right. Use the Mound and Dig tools

to raise and lower terrain to the heights that you want. These tools can create rough-looking terrain, so
use the Smooth Height tool to blend the peaks and valleys into a more natural appearance.

❍ To refine the brush used with each terrain tool, change the properties in the Terrain Brush Options
window that appears when you select a tool. For more information, ➤ Terrain Tools on p. 22.

❍ To see if a piece of terrain can be passed over by a vehicle, select VIEW IMPASSABLE AREAS in the View
menu. Use the Smooth Height tool to make these areas passable, if desired.

7. Add a perimeter to your map. To create a more natural appearance, you should have a fringe of
unplayable terrain around your map that is at least 70 tiles on each side. You should also have terrain on
the edge of your map that units cannot cross. Terrain shapes that begin on the map can use this
perimeter area as overflow, so that you avoid abrupt edges to your maps.

❍ To create a map perimeter, click the Border Tool in the toolbar. Then, click and drag any corner of the
orange perimeter to resize the actual playable surface of your map.

✯ Make sure that the orange border and the blue border cover the same area.
✯ All maps are rectangular in shape, and the lower-left corner of your map perimeter is always fixed.

EA TIP: If you don’t want to create a set of natural elements at the edge of your maps to
create impassable terrain, you can paint textures along your perimeter as impassable. These
textures should be unique and appear impassable. Do it at the end of your development
process. For more information, ➤ Texture Tools on p. 24.
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8. Create waterways. Next, create the bodies of water on your map. Left-click on the Water Tool in the
toolbar. Then, click and drag in the map to create the perimeter of the water polygon. Adjust the settings
in the Water Tool Options window to set the height of the water and the density of control points in it.

✯ When shaping a water polygon, you do not need to fit it exactly to the shape. In fact, you can shape a
water polygon around multiple lake beds or rivers. Create the polygon so that it merely encloses the area.

EA TIP: When possible, use the default water plane in your map. For more information, ➤
New on p. 12.

❍ To reshape your body of water, click and drag any control point.
❍ To create a lake, click CREATE WATER POLYGON. To identify the shape as a river, click RIVER. Then,

click in the area to begin the flow of the water texture.
✯ While lakes have tides, river water textures have flowing currents. For more information, ➤ How to Build a

River on p. 53.
9. Paint textures. Now that all of your terrain shapes have been created, you can paint textures on them to

create realistic map features. In the toolbar, select the Large Tile tool to begin. In the Terrain Material
Options window, you can select the texture and define your texture brush.

✯ Textures are organized in folders based on appearance and geographical connections. All textures in the
same folder should work well together.

❍ To select a texture from the map with which to paint, select the Eyedropper tool in the toolbar. Then,
click the texture to use. That texture can now be painted with the other texturing tools.

✯ You can also fill a defined area with a single texture. For more information, ➤ Terrain Tools on p. 22.

EA TIP: When you select a new texture to paint, place a single-tile swatch of it outside the
perimeter of your map. A texture palette simplifies the selection, tracking, and replacement of
textures on your map.

10.Refine and blend textures. After using the Large Tile and Flood Fill texturing tools to define the large
texture areas, you can use the Single Tile tool to tweak the textures of individual cells. Additionally, you
can blend textures together.

❍ To blend two textures together, click the Auto Edge Out texture tool in the toolbar. Then, select the
texture that you want to blend into the surrounding textures.

NOTE: You can add some three-way blends between textures, but be careful. Don’t have more
than 300 three-way blends on your map, or you may experience performance problems in the
game. For more information, ➤ Auto Edge Out on p. 24.

❍ To blend a single edge of a texture inward, use the Blend Single Edge tool. For more information, 
➤ Blend Single Edge on p. 24.

✯ What about the funny textures on cliffs? When you apply textures to steep surfaces such as cliffs, the
textures are stretched to cover the area. The results can be ugly. To smooth a cliffside texture, select MAP
CLIFF TEXTURES from the Texture Sizing menu. Then, click the texture to map as a cliff. For more
information, ➤ Map Cliff Textures on p. 20.

11. Place combat and civilian objects. Now that you’re satisfied with the terrain and textures of your map,
you’re ready to place objects on the surface.

✯ Place only objects that exist at the beginning of the game. Objects that are appear during the course of
the game are created through scripts. For more information, ➤ Scripts on p. 61.

❍ To place an object on the map, click the Place Object tool in the toolbar. In the window, navigate the
object library tree to find the object to place. Change its properties as needed. Click in the map to place
the object.

❍ To move an object, click and drag it. To rotate it, click the edge of the icon and drag the object to a new
angle. To delete an object from the map, click it and press y.

EA TIP: For a multiplayer game, don’t have more than 100 objects per player on the screen,
or users may experience performance problems. For single-player missions, limit yourself to
1,800 total objects.
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12.Roads, railroads, and bridges. Roads, railroads, and bridges can be key tactical points on your maps
and add color to your urban landscapes. These elements are specialized textures that are treated like
objects. For more information, ➤ How to Build a Road on p. 49, ➤ How to Add a Sidewalk on p. 50, and 
➤ How to Build a Railroad on p. 50.

✯ Groves. You can also use the Grove tool to place natural-looking groves of trees on your map with just a
few clicks. For more information, ➤ How to Build a Grove on p. 52.

✯ Fences. Use the Fence tool in the toolbar to lay down non-military fences. For more information, ➤ How
to Build a Fence on p. 49.

13.Place resources on your map. Supply docks, oil derricks and loose piles of supplies are key elements in
balancing gameplay. Place these items in equal quantity at equal distance from the starting points for
each player.

✯ In the Object library tree, resource objects are located under Civilian\Structure.

EA TIP: A good guideline is to budget $40,000 - $60,000 for each player on the map. If you
exceed this range, you may experience performance problems later in the game due to a large
number of created objects.

14.Create and Name Waypoints. If you’re adding more waypoints for units to follow or as markers for the
placement of other materials, do so now.

❍ To place a waypoint, select the Waypoint tool in the toolbar. Click a location on the map. The waypoint
is created. In the Waypoint Options window, you can change the name of the waypoint. For more
information, ➤ Waypoint Tool on p. 26.

✯ Sets of waypoints can be sequenced together into waypoint paths that units and teams can follow. For
more information, ➤ How to Build a Waypoint Path on p. 48.

15.What’s the ambiance? Ambient sound can be added to your map to add life to the civilian structures on
it. You can add the sounds of dogs, birds, markets, and cars—among others.

✯ In the object library tree, ambient sounds are listed in Civilian\Audio.

EA TIP: Put no more than three ambient sounds in any screen. Test ambient sounds in the
game for appropriateness.

16.Test in the game. When you have finished adding all of the elements to your multiplayer map, test it in
the game. Spend some time in the map as a single player, and test it with a couple of friends who are
willing to help you find problems with it. No one gets it right on the first pass, so be patient with
yourself. The simplest answer is usually the best one.

❍ To open a user-created map in the game, select SOLO PLAY from the Main menu. Then, select
SKIRMISH. In the Skirmish Setup screen, click SELECT MAP. User-created maps are listed under
Unofficial Maps. Select your map, and click ACCEPT. In online multiplayer games, user-created maps are
automatically transferred to all players who join the game.

17.Optimize tiles. During development, you may have blended textures together in order to create subtler,
more realistic effects. However, blended textures can be a burden on the game. Prior to releasing your
map, you should attempt to optimize your texture tiles.

❍ To optimize textures, select OPTIMIZE TILE USAGE from the Texture Sizing menu.
✯ For more information on steps to optimize your map, ➤ Optimizing Your Map on p. 78.
18.Ship It! When you are ready to distribute your multiplayer map, all of your gaming buddies must have it

installed on their system. A completed map should be approximately 1MB and can be emailed as a set
of attachments.

✯ When using multiplayer maps online, the creator of the map should host the game. The map is
automatically transferred to all players that join. Single-player maps must be transferred via email, FTP,
or the like.

❍ To install a user-created map, create a directory inside the Maps directory of the Command & Conquer
Generals game directory. Give the directory the exact name of the map file, minus the filename extension.
Place the map file, the .TGA preview file, and any other related files inside that directory. The map is
then available through the Skirmish Setup screen in the game.
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A FEW EXTRA STEPS FOR
SKIRMISH MAPS
A good multiplayer map makes a good Skirmish map as well, because a Skirmish map is, in fact, a
multiplayer map that is playable by only one player. All other players are controlled by the CPU. The design
of a Skirmish map is identical to the method described to build multiplayer maps, with a few extra steps.
✯ For more information on creating multiplayer maps, ➤ Eighteen Steps to Creating Multiplayer Maps on p. 36.
1. Before you begin building your map, read all of these instructions so that you can plan ahead to convert

your multiplayer map to a Skirmish map.
2. Complete Multiplayer Steps 1 – 17. Build a multiplayer map to completion, including playtesting.
3. Save your completed multiplayer map under a different name. You should work on a separate file for

your Skirmish map.
4. Set up trigger areas for each base. For a Skirmish map, the AI opponents must have some information

embedded into the map so that they can figure out what to defend, what to fight for, and how to attack
the human player. The following steps provide the means for the AI to do so. Each base area needs two
trigger areas defined for the AI, and another trigger area is shared by all CPU-controlled opponents.

❍ To create a trigger area, click the Polygon tool in the toolbar. Left-click the first location for defining the
trigger area. Left-click at the turn points on the perimeter of the trigger area, and then left-click on the
first location to finish creating it.

❍ To assign a name to the created trigger area, type the name in Area Name textbox of the Area Trigger
Options window.

✯ Outer Perimeter. The outer perimeter of a CPU-controlled base is the first stage of alert. When an
enemy unit breaches the outer perimeter trigger area of an AI-controlled base, the available units of the
AI player address the threat. In defining the outer perimeter for a base, you want to make it neither too
big nor too small. When it’s too large, the AI reacts too soon, attacks small scouting parties needlessly,
and exposes himself to counterattacks from other directions. If it’s too small, the AI reacts too late to
prevent damage to the base structures. The name of the outer perimeter for start location #X must be,
“OuterPerimeterX” where X is the number of the start location.

✯ Inner Perimeter. When the inner perimeter of a CPU-controlled base is breached, the AI drops everything
to address the threat. Consequently, the inner perimeter should not be much larger than the base area
itself, as units and defensive structures already created by the AI can address less-than-immediate
threats. However, if a tactical advantage such as a choke point is some distance from the base, it may
make more sense to define the inner perimeter to include that point. The name of the inner perimeter for
start location #X must be, “InnerPerimeterX” where X is the number of the start location.

✯ Combat Zone. Each map must have one and only one combat zone trigger area. The combat zone
encompasses everything that is not part of the base areas or their perimeters. While incursions into the
combat zone do not prompt automatic responses from AI opponents, they do signal to the AI that the
stakes of the game have been elevated. Define the trigger area polygon for the combat zone to be
everything that is not part of a base area. The name of the combat zone polygon must be,
“CombatZone”.
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5. Define entrances to each base with waypoint paths. Did you build three entrances to each base in your
multiplayer map? Those entrances must be identified and named so that the AI can figure out how to
attack each base area. The names to these sets of waypoints are specific.

❍ To define an entrance to a base, click the Waypoint tool in the toolbar. Outside a base, click in a
location that is beyond the outer perimeter and in front of one of the base entrances, and then drag
towards the base to set the next waypoint. Click and drag waypoints until the final waypoint of the path
is just inside the inner perimeter.

❍ To name the created waypoint path, click in the first text box below Waypoint Path Labels in the
Waypoint Options window. Each base needs three waypoint paths under the following naming
conditions:

✯ Center Path. The center path defines the most direct, obvious route into a base. The path must be
named, “CenterPathX” for start location #X. On the easiest difficulty setting, the initial attack usually
comes from this route.

✯ Flank Path. The flank path defines the secondary route into a base. The path must be named, “FlankX”
for start location #X.

✯ Backdoor Path. The backdoor path defines the least obvious and often the most vulnerable route into
the base. The path must be named, “BackdoorPathX” for start location #X. On the hardest difficulty
setting, the initial attack may come from this route.

6. Add Skirmish players. Finally, you must add the AI players to your Skirmish map.

NOTE: Before you add Skirmish players, double-check to see that you do not have another
named player in the Player List. If you add a building for a side that is not yet represented in
the map, World Builder automatically creates the player. Maps with more than one player that
have Skirmish players added to them are invalid for use in Skirmish games. Remove the extra
players and any Skirmish players, and then add back the Skirmish players.

❍ To add Skirmish players, select PLAYER LIST from the Edit menu. Click ADD SKIRMISH PLAYERS. All of
the information needed to add the required number of Skirmish players is included in your map. The
hooks for the AI are integrated through these references. Click OK.

✯ Save and play. Save your map, and give it a try.



BUILDING SINGLE-
PLAYER MAPS
Designing single-player maps is a bit more complicated because the designer is responsible for all of the
challenges. Instead of relying on players to challenge each other, you must present a carefully constructed
set of challenges for a single player.
The time you spent learning the nuances of each side’s strategy and tactics can now be applied to your
single-player designs. While the steps for single-player designs do overlap with multiplayer, there are a few
extra steps to consider when building single-player maps.
1. Additional Design Issues. Before you begin, you should consider all of the issues outlined in Multiplayer

Step #1. Then, you should think of issues specific to single player. What is the “story” of the mission?
Are there any scripted events that happen at the beginning of the mission? Are there “plot points” at
which events should occur? How many sides are on the map? With what resources, structures, and units
does each side begin? Is the player started at a disadvantage? What are the civilian resources?

EA TIP: When designing the story of a single-player mission, keep in mind that the player is
more interested in playing the game than reading text. Storylines should be very clear and
easy to tell. Changes to the plot in the middle of the mission should be direct and re-inforced
with displayed text and physical changes to the map, such as the arrival of new objects from
off-screen.

2. Complete Multiplayer Steps 2 – 10 (➤ Eighteen Steps for Multiplayer Maps on p. 36).
3. Edit the Player List. How many CPU-controlled players are going to participate in the mission? Are there

multiple CPU-controlled players playing the same faction? Are there any alliances? These questions need
answers in the Player List.

O To open the Player List, select EDIT PLAYER LIST from the Edit menu. To create a new player, click NEW
PLAYER. In the drop-down, select the faction template to apply to the player, and click OK. For more
information, ➤ Player List on p. 55.

4. Complete Multiplayer Steps 11 – 14.
5 Write Your Scripts. Scripts determine unit behavior based on events in the game. The essential structure

of a script is: IF (condition), THEN (Action1) ELSE (Action2).
O Scripts are the keys to creating dynamic single-player missions. To open the Scripts window, select

SCRIPTS from the Edit menu. For more information, ➤ Scripts on p. 61.
6. Complete Multiplayer Steps 15 – 18.
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TUTORIAL: HOW TO
World Builder tools are easy to learn and versatile in application. While many of these tools take a few
seconds to master, some of the core design tasks require attention to detail to produce professional-quality
maps. This section covers the step-by-step processes for completing core tasks necessary to build a map,
and you may find a tip or two to simplify development and improve results.
O To learn the names of tools in the toolbar that are referenced in this section, move the mouse and hold

it over a tool.

HOW TO BUILD A HILL
In the World Builder, a hill is created using the Mound terrain tool. By painting over and over an area with
the Mound tool, you heap terrain on top of terrain, creating mounding effects that are smoothed by the
application into the surrounding terrain. With practice, you can learn to create sharp cliffs, craggy
mountains, gentle knolls, and tiny undulations in the terrain.
1. To build a hill, click the Mound button in the toolbar. It looks like a paint brush with a plus sign (+) next

to it.
2. The cursor changes, and the Terrain Brush Options window opens. In the Terrain Brush Options

window, you can configure the Brush Width, Brush Feather Width, and Brush Height before you begin
painting terrain. For more information, ➤ Mound on p. 23.

3. In the map, click and hold the mouse button when the mouse is at the location where you want to add
terrain. As you hold down the mouse button, terrain is added around the cursor according to the
parameters set in the Terrain Brush Options window. Continue clicking, holding, and moving the mouse
back and forth until you’ve created the approximate shape that you want for your mound.

4. To soften the effects of the Mound tool, use the Smooth Height tool in the toolbar, which smoothes
curves along the edge of your terrain shapes. For more information, ➤ Smooth Height on p. 23.

HOW TO BUILD A VALLEY
Building a valley is very similar to the process used to build a hill.
1. To build a valley, click the Dig button in the toolbar. It looks like a paint brush with a minus sign (-) next

to it.
2. Repeat steps 2 – 4 for How to Build a Hill until you are satisfied with the results.

HOW TO BUILD A RAMP
No matter how carefully you add and remove terrain, you’re going to have a very hard time creating smooth
inclines and declines. For these terrain effects, use the Ramp tool.
1. In the toolbar, click the Ramp tool.
2. In the map, click the start location for the ramp and drag to its end location.
3. In the Ramp Options window, select the width for the ramp.
4. To create the ramp of terrain, click PLACE RAMP.
6. The ramp is placed.
O To undo the placement of the ramp, press v + Z.
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HOW TO BUILD AN AREA FOR A BASE
When you design a map, you must designate areas where each side can build its base. A base area must be
of sufficient size to accommodate all of the buildings that the side needs in order to win the map. What is
this size? Unfortunately, there is no golden rule. However, if you follow these steps, you should minimize the
amount of reworking required during the remainder of your designing process.
1. Each base should have a minimum of three entrances to it. Whether the base faces human- or CPU-

controlled opponents, experience suggests that it’s possible to defend two entrances effectively. However,
defending a third entrance is very hard to do. If all bases face similar challenges, the game gets
interesting in a hurry.

✯ For single-player base areas, you should consider the nature of the mission and how much of the tech
tree is going to be available to the base creator. If he can access everything, then the confrontation is
likely to be large and requiring of many base structures. However, for specialized single-player missions
with a reduced tech tree, you may not need to build a large base area. It can be a good idea to give a
human player a few buildings with which to commence the mission.

2. The minimum width for each base entrance is five tank lengths. You can create smaller entrances, but
they are easy to defend and can inhibit CPU-controlled units from finding pathways through them.

3. Place all of the structures that you think the player needs in order to win the game. The USA and
China sides tend to require more space, as they need power and have very large structures like the
airfield. Place all of the structures with room between them so that tanks and infantry can maneuver.

✯ If you’re building a single-player map, you may want to place the structures using the Build List, as you
can see the power requirements needed for the base. If more power is needed, more power plants and,
hence, space are needed.

4. Draw a polygon trigger area around the base area. When you are satisfied that you have enough space
to build your base, draw a polygon trigger area around it. This polygon trigger area is just a marker.

5. Delete the placed buildings. Unless you have placed the buildings using the Build List and intend to
keep them on your map, remove them.

❍ To remove a group of objects, use the Select and Move tool to click and drag a rectangle around the
objects. Then, press y.

6. Flatten out the base area. When you have defined the polygon trigger area, you should make the space
inside of the area as flat as possible. While the building of base structures can flatten some small
undulations in the terrain, structures cannot be built on a slope of any significance. So, it’s best to use
the Height Brush tool to make the surface as even as possible. For more information, ➤ Height Brush on
p. 23.

✯ Don’t worry about scenery objects such as trees and rocks. They are excavated by the construction units
when base structures are built.
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HOW TO PAINT TEXTURES
You can paint textures in large or small tiles.
1. To paint a texture, select either the Large Tile or Single Tile tool in the toolbar.
2. In the Terrain Materials Options window, you can navigate the texture tree to preview and select the

texture to paint.
✯ When you are selecting textures in the Terrain Materials Options window, a percentage is listed before

each texture name. This percentage reflects the memory consumed by painting the texture. For more
information, ➤ Texture Sizing Info on p. 21.

❍ To use the texture partially hidden in the Terrain Materials Options window, click SWAP. This texture
reflects the “midpoint” between the current texture and the macrotexture.

✯ For the Large Tile tool, you can change the width of the brush in the Terrain Materials Options window.

EA TIP: As you paint a new texture, add a one-square swatch of it outside the area of your
map. You can build a palette of all of the textures in your terrain, which makes for easier
selection and replacement of them.

3. In the map, click and drag over the areas to paint with the selected texture. Cover the entire area, and
don’t worry about the shape of the edges.

✯ Don’t overlap textures too frequently. Choose a good macrotexture, and build your texture fields so that
they do not overlap. It’s very easy to create long seams of three-way blended textures by overlapping. You
can create nice effects without the overlap.

EA TIP: When painting textures over a large area, use one base texture over an area and add
a couple of textures for nice effect. Apply the textures using the Flood Fill tool. Keep five grid
cells between blended areas, or you may have to address three-way blends. When in doubt,
start over and repaint.

HOW TO BLEND TEXTURES
After you have painted an area, you may want to blend the texture into the surrounding textures for better
appearance and edging.
❍ To blend the texture into the surrounding areas, select the Auto Edge Out tool in the toolbar. Click

inside the texture area to blend outwards.
❍ To blend a single edge of a texture and smooth its appearance, select the Blend Single Edge tool in the

toolbar. Click and drag from one texture across the sharp edge and into the other. The edge is softened.

HOW TO COPY TEXTURES
While you cannot currently copy texture shapes from one location to another, you can quickly select textures
from one area and apply them to a new one.
❍ To select a texture, select the Eyedropper tool in the toolbar. For more information, ➤ Eyedropper on p. 24.

NOTE: You cannot select blended textures, which are algorithmically created. When you select
a blended texture, you select the texture beneath it. You can then recreate the blend in a new
location.
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HOW TO PAINT PASSABLE AND IMPASSABLE
TERRAIN
During the course of development, your manipulations may create terrain forms that are impassable to
vehicles and units. You can paint those units as passable. Similarly, you can paint passable terrain as
impassable, which is more commonly done.

WARNINGS
It can be tempting to repaint the entire map as either passable or impassable as you see fit. However, doing
so may cause problems, so please read the following warnings and paint with caution.
✯ If there is no gameplay reason for units to cross the terrain, make it impassable.
✯ Do not paint cliffs as passable terrain. It looks bad to have tanks climbing vertical surfaces, as the sense

of a real-world experience is lost. The ability to climb cliffs can cause problems for the long-range
targeting of some vehicles, too.

✯ In general, do not turn terrain that is naturally impassable into passable terrain. In World Builder, terrain
that is steeper than 45 degrees is impassable—and should stay that way.

✯ Resizing the map will cause impassable areas to revert to default 45 degrees.
✯ Do not paint the terrain at the edge of a body of water as passable terrain. Vehicles that pass into water

can get stuck underwater. It’s a much better idea to paint the entire perimeter of a body of water as
impassable.

✯ Do not create islands of passable terrain inside of seas of impassable terrain. For example, if there is a
spot of passable terrain at the top of an impassable mountain, AI players may attempt to drop
paratroopers inside the passable terrain. Units trapped inside a sea of impassable terrain spend the rest
of the game trying to get out and cause a significant impact on the frame rate. Instead, paint the entire
area as impassable.

✯ Do paint impassable textures around the outside of the map perimeter. Particularly for single-player
maps, it’s important to limit the ability to move beyond the map.

✯ Paint impassable terrain beneath boulder objects.
To Paint:
1. Under the View menu, select SHOW IMPASSABLE AREAS.
2. To set the angle at which terrain becomes impassable, select IMPASSABLE AREAS OPTIONS under the

View menu. For more information, ➤ Impassable Area Options on p. 18.
3. To paint terrain as passable or impassable, select the Single Tile or Large Tile tool in the toolbar.
4. At the bottom of the Terrain Materials Options window, check the box next to Paint

passable/impassable terrain. Choose whether you are painting Passable or Impassable terrain.
5. On the map, begin painting the selected textures. Remember to observe the warnings above.
6. When you complete your painting, it’s a good idea to give a texture clue that the ability to pass an area

is not what is expected. For example, if you painted a rocky slope as passable, you should repaint it with
a softer texture. Such painting helps users figure out where to go.
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HOW TO PLACE OBJECTS FROM THE OBJECT LIBRARY
Objects include structures, infantry, vehicles, aircraft, and all types of civilian items.
✯ Place only objects that appear at the beginning of the map. Objects that are created and appear later in

the mission are placed using scripts. For more information, ➤ Scripts on p. 61.
1. From the toolbar, select the Place Object tool.
2. In the Object Selection Options window, navigate the tree to find the object to place. Click the object.
✯ Do not use objects with names beginning with “CINE_”. These objects are for use only when creating

cinematics. They should not be placed on the map.
3. In the map, click the location where you want to place the object. The object is placed.
❍ To place another instance of the object, click in a new location.
4. In World Builder, you can place any object anywhere on the map; the terrain beneath it is not considered.

Either before or after placing the object, you should reshape the terrain for a more natural appearance.
✯ You can partially bury some objects for a different look. For example, a half-buried tree becomes a bush.

However, it’s recommended that you don’t try these effects until you have settled on the shape of your
terrain.

5. After the object has been placed, you can configure its properties. For more information, ➤ Object
Properties on p. 28.

HOW TO ROTATE AN OBJECT
❍ To rotate an object, select the Select and Move tool in the toolbar. Click and drag the outer line of the

icon in the middle of the object. The object rotates.

HOW TO REPOSITION AN OBJECT
❍ To move an object, select the Select and Move tool in the toolbar. Click and drag the object to a new

location. Adjust the terrain and texture underneath the object, as needed.

HOW TO COPY AND PASTE AN OBJECT
❍ To copy and paste an object, select the Select and Move tool in the toolbar. Click the object. Select

COPY from the Edit menu. Then, select PASTE. The object is pasted directly over the original. Click and
drag the copy to a new location.

HOW TO ADD ANY STRUCTURE ON YOUR TEAM
Assigning a placed structure to a defined team requires just a few more steps.
1. Follow Steps 1 – 5 in How to Place Objects from the Object Library.
2. In the Object Properties, select the player team to which the structure belongs from the Team drop-down.
❍ To define a player team, select EDIT PLAYER LIST from the Edit menu. For more information on defining

player teams, ➤ Player List on p. 55.



48

HOW TO ADD AIRCRAFT
Depending on the type and role of the aircraft that you are adding, you should follow these steps.

HOW TO ADD A HELICOPTER
❍ For Chinooks and Raptors that are part of a mission at its beginning, place them on the map like any

other object.

HOW TO ADD A JET AIRPLANE
Only the USA and China sides have jet aircraft.
1. USA Auroras and Chinese MiGs require airfields. Prior to adding these jet planes, you must provide them

with an airfield. To place an airfield, ➤ How to Place Objects from the Object Library on p. 47.
2. After the airfield is placed, you can place up to four jet aircraft at each airfield. To add a fifth aircraft,

you must build another airfield.
✯ At the start of a mission, planes do not have to be placed on an airfield. Planes that begin at an airfield

are assigned to that airfield, while planes that begin away from an airfield try to find one with an
available hangar.

HOW TO ADD AN AIRCRAFT FOR ONE-TIME USE
For cinematic effect or other one-time use, you may want to create aircraft to enter the map, perform a
function, and then exit.
1. To create the aircraft, use the Place Object tool. Place the aircraft outside the perimeter of the map. For

more information, ➤ How to Build a Map Perimeter on p. 54.
2. Define the waypoint path that you want the aircraft to follow. For more information, ➤ Waypoint Tool on

p. 26.
3. Create the script events that 1) create the plane object, 2) define its target and action, 3) cause it to

egress along the waypoint path, and 4) get destroyed after its job is done.

HOW TO BUILD A WAYPOINT PATH
You can develop waypoints or sets of waypoints called waypoint paths which units can be ordered through
scripts to follow during patrols, attacks, or reconnaissance assignments.
✯ Try to design your waypoint paths to be essentially straight. At most, give them a nice arc. Avoid S-turn

paths, as they cause pathfinding problems for units.
1. To begin placing waypoints, select the Waypoint tool in the toolbar.
2. At the location of the first waypoint on the map, click and hold the mouse button. The first waypoint is

created.
3. Drag the mouse to the location of the second waypoint. Click and continue dragging until you have

created all of the waypoints of the path.
4. When you have finished creating the waypoints of the path, enter a unique name for the path in the Path

Labels textbox.
❍ To select all of the waypoints in a path, press v and then click one of the waypoints.
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HOW TO BUILD A FENCE
NOTE: While fences can add nice touches to your maps, each section of fence is an individual
object. Your object counts can climb very quickly if you build a long fence. So, use them
cautiously, and try to select longer fence objects from the object library.

1. Before building your fence, flatten the terrain beneath its location. While you can place fences over
uneven terrain, the results are mixed.

2. Select the Fence tool in the toolbar.
3. In the object library, select the fence object to place. Remember the name of the object that you used.
4. Click and drag each segment of the fence that you want.
❍ To place fence objects one by one, press q as you click locations.
5. Be sure to examine the fence that you placed. You may have to place individual instances of the fence

object to smooth corners or fill in gaps.
✯ It’s a good idea to use the Snap to Grid (➤ p. 19) feature to align fences with the underlying terrain.

HOW TO BUILD A ROAD
A road is treated as an object in World Builder. In the game, however, it is baked into the terrain and
becomes a texture.
✯ You can automatically create intersections that have up to four different roads of the same type. To

create larger intersections or ones involving dissimilar road types, you must take additional steps.
1. Before you place the road, you must prepare the terrain. While roads can climb hills, you should avoid

placing the road on terrain that slopes across the grain of the road. Placement of roads on such terrain
can cause unnatural spiking in the road object. Use the Smooth Height and Height Brush tools in the
toolbar to create a flat bed for your road.

2. To place the road, select the Road tool in the toolbar.
3. In the Road Options window, select the type of road to place.
4. From the start position of the road, click and drag a small section of road. Right-click to move the

screen a bit. Click the end of the first section of road and drag a new section. The corners are
automatically smoothed. Repeat this technique (click-and-drag, right-click, click-and-drag) until you
have created the road.

✯ Don’t create turns in your roads that are greater than 90 degrees. They are unsightly and can cause
performance problems. Create very sharp turns as a series of more gradual turns.

5. When you have finished placing the road, you should check the corners. You can change the smoothness
of the corners.

❍ To change the shape of a corner, click the middle of the corner. An icon should appear. In the Road
Options window, select a different corner type. Click APPLY TO SELECTION. The corner is changed.

6. Intersections. Roads of the same type automatically connect when you bring them together. However,
you can create new intersections after you have placed your entire road.

❍ To create a new stretch of road off an existing road, click in the middle of the existing road at the point
where you want the new road to begin. Drag a stretch of road away from the existing road. The
intersection is automatically formed.

❍ To create an intersection between dissimilar road types, drag the second road to the edge of the main
one. Do not try to overlap the two roads; get them as close as possible without touching. Select the end
of the second road. In the Road Options window, select Add End Cap and click APPLY. A nice
overlapping touch is applied from the second road onto the first.

✯ For intersections involving more than four roads of the same type, you must offset the additional roads
from the main intersection.
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HOW TO ADD A SIDEWALK
The process of adding a sidewalk next to a road is simply adding a second road object parallel to the first.
1. Click the Road tool in the toolbar.
2. In the Road Options window, select the sidewalk to apply.
3. In the map, click the start location of your sidewalk. Try to match the turnpoints and shape of the road.
4. Change the type of corners as needed to get the proper appearance.
5. After you have placed the sidewalk to your satisfaction, you may want to examine the seam between

sidewalk and road. Sometimes, inadvertent gaps appear, which you can cover using specialized textures.
Select either the Single Tile or Large Tile tool in the toolbar. Browse the texture library to find a texture
that blends well between the look of the sidewalk and the road. When it is applied, the texture appears
beneath and between the two road objects.

HOW TO BUILD A RAILROAD
Building a railroad can take some time to do, but the positive effect on the ambiance of your map is worth
effort.
A train does not associate much with the rest of the map or the elements on it. It destroys almost anything
in its path, except for civilian buildings, which may be train stations.
✯ Trains are also very hard to kill. While some cars, including the locomotive are combustible, the

locomotive is the hardest unit to destroy in the game. Only a GLA Demo Trap placed directly in the path
of the locomotive can destroy it.

Follow these steps to build a railroad for your map:
1. Read all of these steps first. Early steps affect later steps.
2. Flatten the terrain for the tracks. If the slope of the terrain is more than one percent (1%), the train’s

appearance may be ugly.
3. Lay down the tracks. Select the Road tool from the toolbar. In the object library, select a railroad type.

Lay down the tracks in the desired arrangement. Get the layout to your satisfaction. It’s best to create
looping track. For more information, ➤ How to Build a Road on p. 49.

4. Lay down the waypoint path for the train. When you set waypoint paths, you need to lay out the
waypoints according to the following rules:

✯ The order in which the waypoints wind must be consistent and in one direction. Do not double-back
your waypoints.

✯ To make the train persist on the map, you must have a closed loop. Trains on tracks with a terminus are
present one and only time in the map.

✯ In turns on your track, place the waypoints very close together. Each change in direction should be slight
in order for the train to see the next waypoint.

✯ Interrupt long, straight stretches of track with waypoints. A rule of thumb is to place a waypoint every
100 map units, which is roughly the length of one reactor object. The train can follow long stretches of
track, but the sound effects are less satisfying.

✯ You cannot have diverging waypoint paths or tracks. You can have two tracks converge into one, and the
second track must join the first in one and only one place.

✯ For more information on building waypoint paths, ➤ How to Build a Waypoint Path on p. 48.
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5. Associate the train with the track. Select the Place Object tool from the toolbar. Select a train engine
object from the Civilian Vehicle category of the object library. Place the icon of the engine on top of a
waypoint, its arrow pointed in the direction of the next waypoint.

✯ You can have only one engine per train.
✯ You can place multiple trains on a single track. If they collide, they can explode.
6. Place the cars of the train behind the engine. Each car must be placed directly behind the car in front

of it, and its arrow must point towards the center of the car in front. You can string trains around
corners.

✯ If no car is placed behind the engine, a default set of cars is used.
✯ Trains can be of any length.
7. Add stations. To define Waypoint12 as a station, for example, change its name to “Waypoint12Station”

with a capital “S.” In the game, the train stops at that waypoint for 10 seconds before continuing.
✯ Ping-Pong stations. A train leaving a Ping-Pong station exits in reverse to create a shuttling behavior. To

define a waypoint as a Ping-Pong station, give it the name, “NamePingPong”. To create a Ping-Pong
railroad, you must have two Ping-Pong stations and a closed loop, and the train must be started
between stations.

8. Add a station object if you want. Although they are not necessary, train stations are in the Civilian
category of the object library.

9. Bridges and Tunnels. Trains normally follow the changes in terrain. However, to build a tunnel or a
bridge, the train must follow the direct line between two waypoints.

❍ To define an upcoming segment as a bridge or tunnel, select the first waypoint and give it the name,
“NameTunnel”. The train follows the straight line between that waypoint and the next one.

10.Add tunnel entrances. For tunnels, you should place a Civilian tunnel entrance object in front of the hill.
11. Test your railroad in the game. Watch a few cycles of the train’s path to see how well it works.

HOW TO BUILD A BRIDGE
When you build a bridge, you must prepare the terrain before laying down the bridge. The heights of the
two ends of the bridge must be roughly equal. While you can have discrepancies of a couple feet, you should
avoid creating bridges that have significant slope to them, as they create pathfinding problems for the units.
✯ You cannot create turns in bridges. To create a turn in your bridge, build a an island at the turnpoint.

The island should be wider than the bridge and large enough to serve as a gathering point for armies
crossing the bridge.

1. Check the height of each terminus of the bridge or bridge segments. The heights of a segment should be
within a few feet of each other.

2. Select the Road tool in the toolbar.
3. Navigate the Bridges category of the object library to find the bridge you want to place.
4. Click and drag from one bridge endpoint to the other. Make sure that you have plenty of overlap onto

the ground next to the gap. Do not create bridges that barely touch the edges of the gap, as units may
not be able to cross them.
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HOW TO BUILD A GROVE OF TREES
Using the Grove tool, you can create random groups of multiple types of trees to give your vegetation a
natural appearance. Some tips:
✯ Trees are objects and can impact performance in large numbers. You can create nice effects with as few

as six total trees. Create groves of more than 40 trees only if you’re sure you want them.
✯ When creating forested areas, remember that you are creating the impression of a forested area; you are

not creating an entire forest. If the player is not going to spend much time in the area or won’t cross the
forest at all, then you might be able to just place trees around the edge of the area.

1. Select the Grove tool from the toolbar.
2. In the window, enter the total number of trees to create in the Total Tree Count textbox.
3. To allow placement of trees in water, click the appropriate box. Make sure that water is shallow enough.

Submerged trees are hard to find.
4. To allow placement of trees on cliffsides, select the appropriate box. Avoid placement of trees on nearly

vertical cliffsides.
5. In the tree drop-downs, select the types of trees that you want to add to your grove. Enter the

percentages for the selected trees.
✯ The total number of trees is always created, regardless of whether the percentages add to 100.
6. On the map, click and drag a rectangle for your grove. When you release the mouse button, the trees are

placed.
❍ To undo the placement of the grove, press v + Z.
❍ To delete an individual tree, click and press y.
7. When you have placed your grove, check to make sure that all trees are in good positions. You can move

trees individually, select them using the Select Similar menu command, or rotate the camera to view the
grove from another angle.

8. If you need to add trees, you can add them individually or use the Grove tool again.

HOW TO BUILD A LAKE USING THE DEFAULT WATER
PLANE
Each map contains a default water plane, which sets the “sea level” for the entire map. Whenever possible,
use the default water plane, as it is inexpensive in terms of system resources in World Builder and the game.
The default water plane can be raised and lowered. Where possible, create your largest body of water using
the default water plane.
1. If you have not done so, use the terrain tools to dig the bed of your lake.
2. Click the Water tool in the toolbar.
3. In the map, find the blue polygon on the perimeter of the map. That blue polygon defines the default

water plane.
4. To reshape the default water plane, click and drag any corner. When shaping the water plane, you are

not defining the perimeter of the lowest lake; you are using the polygon to define the water level for a
specific area of the map. The default water plane does not have to mark the perimeter; it simply must
encompass it.

5. In the Water Options window, you can apply a name to the default water polygon, and you can use the
slider bar to change the height of the water level. Changes to the water level update in real-time.

✯ The other options in the Water Options window do not apply to the default water plane.
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HOW TO BUILD A LAKE USING WATER POLYGONS
If you are building more than one body of water in your map, you can create additional water polygons to
turn into lakes.
1. If you have not done so, use the terrain tools to dig the bed of your lake.
2. Click the Water tool in the toolbar.
3. In the Water Options window, click CREATE WATER POLYGON.
4. Click the start point for the water polygon. Click the location of the next point. Continue clicking at the

turn points around the perimeter of the bed of the lake until you return to the start point. The water
polygon is created.

✯ Note the control points that define the shape of the water polygon; these are expensive resources. If
possible, increase the Point spacing for your polygon. A water polygon does not have to form-fit the
hole. It just needs to surround the lake bed. A good starting point for the Point spacing for a lake is 50.

5. Use the Water Height slider to adjust the water level of the polygon until you have created a desirable lake.
6. If needed, you can reshape the terrain around the lake bed to get a more desirable appearance to the

shape of your lake.
7. When you are satisfied with the appearance of your lake, it’s a good idea to paint impassable terrain

tiles around its perimeter. For more information, ➤ How to Paint Passable and Impassable Terrain on p. 46.

HOW TO BUILD A RIVER
Building a realistic river takes a few more steps than building a lake.
1. If you have not done so, use the terrain tools to dig the bed of your river. Due to technical

considerations, rivers tend to look better if they are wider at both ends. You can put the ends of your
river outside the map perimeter to hide them while creating a better appearance to the river on the map.

✯ Remember that a real river flows down a slight grade.
2. Click the Water tool in the toolbar.
3. In the Water Options window, click CREATE WATER POLYGON.
4. Click the start point for the water polygon. Click the location of the next point. Continue clicking at the

turn points around the perimeter of the bed of the lake until you return to the start point. The water
polygon is created.

✯ The water texturing system uses the control points of a river polygon as anchors in shaping the image of
the flowing water. So, you need to pay attention to their count and positioning while creating rivers. If
you are creating a bend in the river, there should be roughly an equal number of control points on the
inside and the outside of the bend, with the points on the outside of the bend spaced further apart.

5. When you are satisfied with the shape of the water polygon, click the control point from which the river
flows. Click RIVER. The water now flows away from this point.

6. You may have to manually tweak the positioning of the control points to get the flowing appearance of
the water to look correct.
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HOW TO BUILD A MAP PERIMETER
The map perimeter defines the playable area for the player and all of the units in the game. Each map must
have at least one map perimeter. During the course of a mission or game, you can activate and deactivate
map perimeters to change the boundaries of your map on the fly. This technique is particularly useful for
single-player missions in which the user should proceed step-by-step from one challenge to the next.
1. To show the current map perimeter, select SHOW MAP BOUNDARIES in the View menu.
2. In the toolbar, click the Border tool.
3. If you have not yet made changes to the map perimeter, the default orange one encompasses the exact

size of the map.
❍ To resize the default orange perimeter, click and drag the northeast corner of the perimeter.
4. To create a new map perimeter, go to point 0,0 on the map. Click and drag to create a new perimeter.
✯ You can create up to nine map perimeters. Each perimeter always starts at point 0,0, which is always the

lower left corner even if you resize your map.
5. After you have created a new perimeter, you can reference all perimeters through scripts by color. In the

Script window, look for the “Change Active Script Boundary” action. Select the color of the new map
perimeter from the drop-down list.

HOW TO CHANGE THE TIME OF DAY
You can create map environments set at any time of day.

NOTE: When you change the time of day for your map, all structures, bridges, and some other
props are automatically re-textured. However, many map elements are not re-textured, so it’s
recommended that you decide the time of day at an early stage of development.

1. From the Edit menu, select MAP SETTINGS.
2. In the Map Settings window, select a different time of day under the Time of Day drop-down. Click OK.

HOW TO MAKE A MAP AVAILABLE TO THE GAME
If you have saved your map in a non-standard directory, you must follow these steps to make it available to
the game.
1. From the File menu, select SAVE AS….
2. In the Save dialog box, click USER MAPS.
3. Enter a name for your map. Click SAVE.
✯ If the User Maps directory is a new location for your map, remember to reconcile the new file with the

old one. Do not have two files with the same name containing different versions of your map.
❍ To open a user-created map in the game, select SOLO PLAY from the Main menu. Then, select

SKIRMISH. In the Skirmish Setup screen, click SELECT MAP. User-created maps are listed under
Unofficial Maps. Select your map, and click ACCEPT.

HOW TO BUILD A DAM
In a word: don’t. The dams in the single-player campaigns took a great deal of time and special coding to
create. If you would like to have the visual of a dam in your map, you can place the object, but be sure to
check that it is Indestructable and Unselectable in the Object Properties window.
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PLAYERS, TEAMS, AND THE
BUILD LIST
Using the Player List and the Build List, you can define the CPU-controlled players in the map and the order
in which they develop their bases.
Teams are groups of units that can be assembled by CPU-controlled players based on a set of priorities and
conditions and then given orders. For more information, ➤ Building Teams on p. 56.

PLAYER LIST
In the Player List, you can add new players to your map, and edit their settings, including any alliances.
❍ To open the Player List, select EDIT PLAYER LIST from the Edit menu.
In the Player List window, the current players in the game are listed at the top of the screen. All objects that
have been placed in the map yet have not been assigned to a player are part of the Neutral player.
To create a new player:
1. In the Player List window, click NEW PLAYER.
2. In the window, select the faction for the player from the drop-down list. Click OK.
✯ For multiplayer maps, you can create an Observer faction to allow players to view the game without

participating. Defeated players are switched over to the Observer faction.
❍ To delete a player from the Player List, select the player’s name. Click REMOVE PLAYER.
3. Player Name. The new team appears in the Player List. To change the name of the player, enter a new

name and the displayed name in the appropriate boxes. Click SET NAME.
✯ The Player name is its reference for use in scripts. Display name appears on-screen in the game for CPU-

controlled players.
4. Human or CPU. To register the player as a CPU-controlled side, check the appropriate box.
✯ By definition, single player maps have only one human-controlled player. For multiplayer maps, a

human-controlled player must be created for each potential participant in a game.
5. Factions and Colors. To assign the player to a different faction, select a new one from the Faction drop-

down. To change the color of the player’s units and structures, select a new color from the appropriate
drop-down.

6. Allies and Enemies. At the bottom of the screen, you can review the allies and enemies for the selected
player. The other players are listed in each box.

❍ To make a player an ally of the selected player, click the player’s name in the Allies box. The player listing
changes under How Player Regards Others.

❍ To make a player an enemy of the selected player, click the player’s name in the Enemies box. The player
listing changes under How Player Regards Others.

NOTE: It is possible for Player A to see Player B as an ally while Player B sees Player A as an
enemy. Player B can then massacre Player A without any return fire. Such possibilities are
useful for scripting set pieces, but be careful in using them.

❍ To toggle the selected player’s regard for an enemy between ENEMY and NEUTRAL, click the player
name under Enemies. The player listing changes under How Player Regards Others.

✯ The How Others Regard Player box displays the views of other players towards the selected one.
❍ To make a player an enemy, click the player name in the Enemies box. The player listing changes under

How Player Regards Others.
7. Skirmish Players. If you are making a Skirmish map, you add Skirmish players as the final step to

creating your map. The Skirmish players are controlled by AI. For more information, ➤ A Few Extra Steps
for Skirmish Maps on p. 40.

❍ To add Skirmish players to your Skirmish Map, click ADD SKIRMISH PLAYER.
8. To finish editing the Player List, click OK. To cancel your edits, click CANCEL.
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BUILDING TEAMS
In World Builder, you can create team structures so that CPU-controlled players can assemble groups of units
to attack opponents, defend their bases, and secure territory on the map. In no small measure, the presence
and structure of teams determine the ability of a computer opponent to present a worthy challenge.
Teams can be created from units that are on the map at the beginning of the game or from units that the
player has yet to create. Each team can be assigned a set of scripted behaviors to be applied on a variety of
triggers.
❍ To open the Teams window, select EDIT TEAMS from the Edit menu.

TEAMS WINDOW
In the Teams window, a list of available players is displayed on the left side of the screen. Created teams for
the selected player are displayed on the right.
❍ To create a new team, select a player. Then, click ADD NEW TEAM. For more information, ➤ Creating a

Team below.
❍ To copy a team, select the team and click COPY TEAM.
❍ To delete a team, select the team and click DELETE TEAM.
❍ To edit a team, double-click on it. For more information, ➤ Creating a Team below.
❍ To move a team up or down in the list of teams for organizational purposes, select the team and click

MOVE TEAM UP or MOVE TEAM DOWN.
❍ To display the number of units on the map already associated with the selected team, click SELECT

TEAM MEMBERS.
❍ To accept the team definitions, click OK. To cancel edits, click CANCEL.

CREATING A TEAM
When you choose to create a team, the Edit Team window opens. Each of the four tabs is fairly detailed, so
it’s recommended that you start by building simple teams to complete basic actions.
❍ To create the team, click OK. To cancel, click CANCEL.
❍ To apply changes to the team, click APPLY.

EA TIP: Since some units require faction structures in order to be created, your Build List for
the player should be synchronized with the priorities of teams created in the Teams window.

IDENTITY TAB
In the Identity tab, you configure the basic characteristics of the team.
✯ Name. The name of the team must be unique and is the reference used in scripts.
✯ Owner. Select the player to which the team belongs.
✯ Maximum Quantity. Enter the maximum number of teams of this type that can be on the map at any

time.
✯ Home Position. The reference to the named waypoint where the team rallies as it is assembled.
✯ Condition. A reference to the script that allows the AI to build this team. The script must be a

subroutine that has a condition. When the script condition is met, the AI considers building the team,
based on the priorities of all active teams.

✯ Execute associated actions. When it’s checked, the AI executes the actions of the script referenced as the
Condition. By default, the script’s actions are ignored.

NOTE: The condition checked under Production is examined when the team has been authorized
to be built. This subroutine is not a substitute for On Create under the Behaviors tab. If you are
referencing a subroutine through the Condition drop-down, that subroutine must contain a
condition, as the subroutine may fire before the team is actually produced. To execute the
associated actions of that subroutine, check the box next to Execute associated actions.
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✯ Priority. The priority for a team indicates to the AI the importance of building the team. A higher priority
number is more important. You can set the priority to be any positive integer, yet be sure to use a
consistent range.

✯ Build for. When a team’s script condition and priority have been met, the AI attempts to build the team
for the number of frames in this field. Time in the game corresponds to 30 frames/second in most cases.

✯ Success/Failure Priority Increase/Decrease. Whether a team succeeds or fails in completing its
objective, you can increase or decrease the priority for creating another instance of the team.

NOTE: In the Success and Failure priority settings, you can enter both positive and negative
numbers. While you are learning to develop teams, you should ignore changing priorities.

✯ Min, Max, and Unit Type. On each line, you select a type of unit to include in the team. Select a unit
type from the drop-down list, and enter minimum and maximum numbers for the units in the team. If a
team reaches its Build For limit, the team is deployed if it contains the minimum number of units. Else, it
continues building until that minimum is reached.

✯ Automatically reinforce whenever possible. When it’s selected, the AI attempts to bring reinforcements
to this unit until it reaches maximum strength.

✯ Team members are AI recruitable. A team with higher priority settings than the current one can recruit
members from this team to it.

NOTE: Team settings, such as AI Recruitable, override settings for individual units.

✯ Team created once and only once. This team is created one and only one time during the game.
✯ Team Description. You can add a custom description and notes pertaining to the team and its function.

REINFORCEMENT TAB
Under the Reinforcement tab, you define the reinforcements for this team.
✯ Deploy by. To deploy reinforcements by another vehicle, check the box and select the vehicle type from

the drop-down list. The deployment vehicle appears on the map, delivers the reinforcements, and then
leaves the map forever.

✯ Start teams or transports at waypoint. Select the waypoint where reinforcements rally before deploying.
✯ Load members into transports (if applicable). When it’s checked, all members of the team are

automatically loaded into the transport.
✯ Veterancy level. Units must be at least at the minimum veterancy level to be recruited. This setting does

not affect units that are created to become reinforcements.
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BEHAVIOR TAB
In the Behavior tab, you can define the team’s behaviors based on the events listed in this tab.
✯ In subroutines referenced in this window, you can use the drop-down selection, “<This Team>” to

indicate this defined team.

NOTE: Scripts referenced in the drop-down lists must be subroutine scripts. When the
condition in this tab is met, the subroutine is activated, and its condition is tested. If you want
the subroutine’s actions to be executed in all cases, leave the subroutine script’s condition to
be the default (TRUE).

✯ On Create. Subroutine is activated when the team is created.
✯ On Enemy Sighted. Subroutine is activated when an enemy is sighted.
✯ On All Clear. Subroutine is activated when the team detects no enemies.
✯ On Destroyed. When the selected percentage of units in the team is destroyed, the AI activates and tests

the selected subroutine script.
✯ On Idle. Subroutine is activated when the team is in the Idle state.
✯ On Unit Destroyed. Subroutine is activated when a unit of the team is destroyed.
✯ Transports return to base after unloading. When it’s checked, all transports in the team return to base

after their cargo has been released.
✯ Team avoids threats. When it’s checked, the team makes an effort to circumvent threats when headed

to its goals.
✯ Initial Team Behavior. Select the initial AI aggressiveness, which overrides the setting of any individual

unit.
✯ Attack: Does this team focus on a single target at a time in Hard and Brutal (never in Normal)? When

it’s checked, the team aggressively pursues a single target in the harder difficulty levels, which creates a
greater challenge for the player.

GENERIC TAB
Under the Generic tab, you can select one or more subroutine scripts to be active and tested after the team
has been built.
❍ To apply a generic subroutine to the team, select the subroutine from the drop-down list. Another slot

appears so that you can select another subroutine.

TEAM BUILDING TIPS
✯ For single-player missions, check what the player is doing through scripts. Then, depending on player

action, you can build teams to present a good challenge.
✯ To just keep the player busy, create and send teams with just one type of unit. For a better challenge,

create teams of mixed unit types.
✯ Attack the player early. Speed matters.
✯ Through scripts, you can learn more about the player than he can learn through radar. Build “radar”

scripts to increase the challenge. Avoid this technique in multiplayer.
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BUILD LIST
The Build List tool lets you sequence the construction of structures for all CPU-controlled players. Through
the Build List, you can add buildings aligned with a player to the map, choose whether they exist at the
beginning of the mission, and sequence their order of construction.

NOTE: You must create a Build List for CPU-controlled players in a single-player map. In
multiplayer maps, these players can default to use a template.

❍ To open the Build List window, click the Build List icon in the toolbar.
Through the Build List window, you can add structures or assign existing ones to a player’s side.
❍ To begin assigning structures for a CPU-controlled player, select a player from the drop-down list.
✯ For more information on creating CPU players, ➤ Player List on p. 55.
For each CPU player, buildings are constructed in the order that they appear in the Build List.

EA TIP: You can use the Build List to influence the overall challenge of your mission.
Prioritizing the buildings to construct affects the quality and nature of the strategy of the CPU-
controlled player. For example, if an enemy base is located far away, you may set the Build
List to rapidly achieve air power so that it can begin to inflict damage on the opposition earlier
in the campaign. As your skills in the game improve, you can apply what you learn into the
Build List.

To add a structure to the Build List:
1. To add a structure to the Build Map for the selected player, click ADD BUILDING.
2. In the window, navigate the structure library tree to find the structure to add.
3. With the window still open, click a location on the map to place the structure. The structure is placed

and listed in the Build List. On the map, structures placed through the Build List have a multicolor glow
to them.

4. You can click again to place another instance of the selected structure, or you can select another object
in the window to place.

5. To finish placing objects, click OK.

NOTE: Faction structures that are added to the map with the Place Object tool are assigned to
the faction and can be referenced in scripts. However, if they are destroyed, they cannot be
rebuilt by the faction. So, place faction buildings through the Build List tool.
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RE-ORDERING THE BUILD LIST
After you have placed objects, you can change the order in which they are built through the Build List.
❍ To indicate a structure is on the map at the beginning of the mission, select the structure. Then, check

the box next to Structure Already Built.
❍ To change the placement of a structure in the Build List, select the structure. Then, click the UP or

DOWN buttons to move it in the Build List.
❍ To remove a structure from the Build List and the map, select the structure. Then, click DELETE.

BUILD LIST PROPERTIES
For each structure in the Build List, you can assign properties to it.
✯ Z. The Z distance refers to the elevation of the structure above or below the terrain. A figure of 0 is on

the terrain, and negative values embed the structure in the terrain.
✯ Angle. A structure can be placed at any angle of the circle. A figure of 0 points the structure due East,

and positive value turn it towards the North.

EA TIP: For best visual effect, place your structures at an angle of –45 degrees.

✯ Rebuilds. You can set the number of times that the structure can be rebuilt by the player if it is
destroyed. In the Rebuild drop-down, select NONE to disallow rebuilds or UNLIMITED to allow
perpetual rebuilding.

✯ Power Used. The structure’s power meter indicates the total amount of power used by the side after the
selected structure has been built—assuming that all previous structures in the Build List have been
created and are still standing.

✯ Object Properties. A placed structure is also an object that has configurable properties. For more
information, ➤ Object Properties on p. 28.
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SCRIPTS
The Scripts facility is the mechanism for creating mission briefings, introductory sequences, ramping of
difficulty, behaviors of ambient objects, and the tactics of CPU-controlled opponents. Using a simple,
descriptive format, you can build very powerful scripts to govern game events, unit actions, and other
environmental variables in your map.

NOTE: Scripts are not the only way to change unit and team behavior. Setting the basic
aggressiveness level for a unit or team goes a long way towards creating worthy opposition.

❍ To open the Scripts tool, select SCRIPTS from the Edit menu.
In the Scripts window, you can see the Scripts library tree at the top of the screen, and a folder for every
player that you have created.
✯ You may end up creating up to 100 scripts for your mission, so the folders in the Script window become

an important organizational tool. For more information, ➤ Organizing Your Scripts on p. 64.

CREATING AND EDITING SCRIPTS
The structure of a script is fairly simple:
IF (condition), THEN (Action1) ELSE (Action2).
Conditions are triggered by various kinds of events in the game. So, you can trigger a script at a specific time
during the mission or when a trigger area has been breached. You can also trigger scripts when objects are
created or destroyed.
However, the results can have huge and sometimes conflicting effects on events during a mission. So, as you
learn to create scripts, start with very simple ones, and then slowly add complexity.
✯ It’s very important to test your scripts in the game as you develop them. If you write many scripts before

testing, then you may have difficulty figuring out which ones are creating problems.

TO CREATE A NEW SCRIPT
EA TIP: Avoid creating scripts that must occur after the start of the game. You want to keep
single-player missions as open as possible, and the outcome should always be determined by
user action.

1. To create a new script, click the folder in which you want to place the script.
2. Click NEW SCRIPT. In the Script Builder window, enter a name for the script in the Script Name textbox.

EA TIP: It’s a good habit to name your scripts in a logical and consistent manner. For
example, the names of scripts that apply to one player might all begin with the player’s name
followed by an underscore (_) and an identifier for the script.

3. Script Properties tab. you set the flags and difficulty settings that apply to the script.
✯ Subroutine. A subroutine script is referenced by another script. Until it is specifically called by another script,

a subroutine script is not executable and does not consume any CPU resources to check its conditions.
✯ Active. Active scripts can be triggered as soon as the mission starts. Scripts can be activated and

deactivated by other scripts.
✯ Deactivate upon success. After a script has been executed, you can prevent it from being executed again.
✯ Active in. Use the Active In settings to establish the difficulty levels in which the script can be used. For

more information on ramping difficulty, ➤ Ramping Difficulty on p. 63.
✯ Script Comment. This catch-all field is useful for writing notes to yourself about bugs, implementation

tricks, version control information, or tasks to complete related to this script.
4. Script Conditions tab. You define the condition or conditions to be tested and met before the script is

executed.

EA TIP: The default condition for a newly created script is TRUE. If this condition is not
changed, then the script actions are executed as soon as the map is loaded and the game
begins. Use a True condition to execute scripts at the beginning of the mission. If you are not
using the default condition, delete it.



62

❍ To create a new script condition, click NEW. In the window, select a condition from the drop-down list.
The condition is displayed. Click any blue links to define the condition from the available list of
parameters. To define the condition, click OK.

NOTE: There are quite a few different conditions from which to choose, and you can build
very complicated scripting conditions if needed. However, it’s recommended that you begin
with simple conditions to learn how the Script tool works.

✯ When you create multiple conditions, it is assumed that they are connected by a logical AND. To create
a second condition with a logical OR, highlight the condition to compare, click OR and then click NEW
to define the second condition.

❍ To duplicate a condition, select it and click COPY. To delete a condition, select it and click DELETE.
❍ To move a condition in the window, click MOVE UP or MOVE DOWN.
5. Actions if True tab. You define what happens if the condition or conditions are met. The controls are

similar to the Script Conditions tab.
✯ By default, a script does nothing if its conditions are true. To create an action, delete the default action.

Then, click NEW to create the new one.
6. Actions if False tab. You define what happens if the condition or conditions are not met. The controls

are similar to the Script Conditions tab.
✯ The False condition does not often need to be defined. In most scripts, you can leave this area blank.
7. Your script has been defined. To create the script, click OK. The script is now listed in the script

directory.
❍ To view a created script, select it in the Scripts window. The contents of the script are displayed at the

bottom of the window. To edit the script, click EDIT.
✯ For more information on the Scripts window, ➤ Organizing Your Scripts on p. 64.

MAP TOOLS FOR SCRIPTING
Two tools in World Builder can be very useful to identifying locations and areas for use in scripts.
✯ Polygon Tool. Use the Polygon tool to define trigger areas that can be referred to by name in scripted

conditions and actions. For more information, ➤ Polygon Tool on p. 26.
✯ Waypoint Tool. In addition to defining unit movements, you can use waypoints to identify locations on

the map for your scripts. For more information, ➤ Waypoint Tool on p. 26.

MISSION INTROS
You can create mission briefings and scripted introductory sequences using scripts.
✯ Start Mission events. Unless they are subroutines, scripts created with the default TRUE as the

condition are executed as soon as the map is loaded.
✯ Multimedia. You can create a wide assortment of visual effects. Look in the Multimedia category for

available actions.
✯ Disabled Input. In the User category, you can disable user input until the scripted intro sequence is

completed.
✯ Camera effects. You can script a variety of camera effects including letter box and black-and-white

modes. See the Camera category of actions.
✯ Variables. Under the Scripting category, you can define and use variable counters, as well as set and

manage timers. Variables and timers can be referenced by any script in the map.
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RAMPING DIFFICULTY
The Active In settings are the primary mechanisms for ramping difficulty in your maps. When building maps
with variable difficulties, you should begin by creating all scripts on the either the hardest or easiest difficulty
setting.
When you have completed the map to your satisfaction for the defined difficulty level, adjust the Active In
settings of your scripts to test them under other difficulty settings.

EA TIP: When you create a team under Brutal difficulty setting, break it up into multiple
teams. Then, you can reduce the number of teams for easier difficulty settings. For Hard and
Brutal settings, you can set the Attack checkbox under Behavior to make units more
aggressive.

As a final resort, you can write new scripts for the other difficulty levels. The Copy feature works well if you
need scripts that are identical except for a few small changes.

ORGANIZING YOUR SCRIPTS
In the Scripts window, you can organize your scripts to simplify their development and editing. By creating
and moving folders, you can keep track of the location of your scripts.
❍ To toggle the active state of a script or folder, right-click on the folder. Select the menu item to toggle

the state. All scripts inside an inactive folder are not available, which is useful for debugging purposes.

NOTE: You cannot delete or disable the base folders for players that have been created.

✯ If a script has a red question mark over its icon in the Scripts directory, some element of the script has
not been defined.

SCRIPT FOLDERS
The Scripts window organizes scripts like the files in a directory. Scripts should be placed in the same folder
if they refer to each other, apply to a set piece event in the mission, or link together through another
grouping mechanism.
❍ To create a new folder, click NEW FOLDER. In the window, enter a name for the folder. Select whether

the folder is full of subroutine scripts and whether the folder scripts are active at startup.
Some folder creation tips:
✯ Put scripts that apply to all players in the Neutral folder. These scripts include map initializations, win

conditions, and loss conditions.
✯ Scripts that apply a player should be placed in the player’s folder.
✯ Inside a player’s folder, you can organize scripts by geographic area, stage of the game (Begin, Middle,

or End), or another logical convention.

COPYING AND DELETING SCRIPTS
After scripts are created, you can use them as templates to build other scripts. You can also move them to
other folders.
❍ To copy a script, select it and click COPY. The copied script is placed in the same directory as the source

and given a name with a “C” at the end.
❍ To move a script, click and drag it to a different folder.
❍ To delete a script, select it and click DELETE.
❍ To cancel your edits in the scripting window, click CANCEL. All unsaved changes are discarded.
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IMPORT AND EXPORT
Scripts can also be imported to and exported from a map for use in other maps.
✯ If you are logical and consistent in the naming of your map elements, then it is much easier to reuse

scripts from one map in another.
❍ To export a script, select it and click EXPORT SCRIPTS. In the dialog, select the options for your export.

Click OK. Select a destination for the .SCB file, enter a name, and click OK. The selected scripts are
exported.

✯ Exported scripts are in a binary form and should not be edited in a text editor.
❍ To import a script, click IMPORT SCRIPTS. Navigate your local computer to find the .SCB file to import.

Select the file, and click OK. The script or scripts are imported.

SCRIPTING VARIABLES
As part of your map designing toolkit, variables can be defined for all kinds of information in the game. You
can use flags to track binary states, timers to monitor game time, and counters to watch numbers of units
on a side or in a trigger area.
✯ Due to technical limitations, you cannot compare a variable to another variable in scripts. Variables can

be compared to fixed values.

FLAGS
A flag is variable that you can set to TRUE or FALSE. Flags are very useful in testing and tracking whether
events have occurred in the game. For example, you may want to change the behavior of the AI after a player
has crossed into a new area of the map.
❍ To create a flag, use the action [Scripting] Set flag to value. Click the links to enter a name for the flag

and an initial value for it.
✯ When a flag has been defined, its default value is FALSE. After it has been defined anywhere in your

map’s scripts, the flag exists and can be accessed by any script.

USEFUL ACTIONS
❍ To change the value of a flag, use the same action ([Scripting] Set flag to value) that was used to create

it. Enter a different value for the flag.

COUNTERS
A counter allows you to count integer numbers. You can use counters to track the number of times a
repeated event occurs, such as attacks by one player against another. They are also useful in missions in
which the player must destroy a fixed number of units before the mission is successful or switches to a new
phase. Since the scripting system of World Builder contains so many inherent counters for things such as the
number of units, counters are not used frequently.
❍ To create a counter, use the action [Scripting] Counter – set to a value. Enter a name and an initial

value for the counter.
✯ When a counter has been defined, its default value is 0. After it has been defined anywhere in your

map’s scripts, the counter exists and can be accessed by any script.
After a counter has been created, it is available through drop-downs in the scripting system wherever a
counter can be applied.

USEFUL CONDITIONS
✯ [Scripting] Counter Compared to Value: Use this condition to compare a counter’s value to an entered

value.

USEFUL ACTIONS
You can fire actions when a timer has reached 0 seconds or frames. The Timer Expired condition is useful for
scripted cinematics or for delaying action.
✯ [Scripting] Counter – Increment: Add the entered value to the selected counter.
✯ [Scripting] Decrement Counter: Subtract the entered value to the selected counter.
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TIMERS
Countdown timers monitor the passage of time in the game. Timers come in two varieties: Seconds timers
and Frame timers. Both timers assume that in the game one second equals 30 frames. On faster machines,
the game can perform at this rate. On a machine that is producing 18 frames/second, the rate for timers is
still assumed to be 30 frames/second. So, on a slower machine, while 30 frames may last nearly two seconds
in real time, they are treated as a single second in game time.
✯ Avoid using timers in multiplayer missions.
❍ To create a Seconds timer, use the action [Scripting] Seconds countdown timer - set. Enter a name for

the timer and its initial value in seconds. The timer begins as soon as the script is executed.
❍ To create a Frame timer, use the action [Scripting] Frame countdown timer - set. Enter a name for the

timer and its initial value in frames. The timer begins to count down frames as soon as the script is
executed.

✯ The [Scripting] Frame countdown timer – random action lets you set up frame timers of random
duration, which is useful for creating the appearance of random behavior in your maps.

Timers always count down from the start time that you set. A timer can be used as a counter, too. You can
perform all of the operations on a timer that you can perform on a counter.

USEFUL CONDITIONS
When scripting timers, there are some useful conditions that you can test to determine if action should be
taken:
✯ Timer Expired: You can fire actions when a timer has reached 0 seconds or frames. The Timer Expired

condition is useful for scripted cinematics or for delaying action. For pacing purposes, you may want to
use timers to delay counter-attacks from the AI.

✯ Counter Compared to Value: Use this condition to compare a named timer to an entered value. Note
that the default setting is “less than zero.” If you don’t set a positive value for the counter, the condition
never fires.

CONDITIONALS
When you have multiple conditions to test in a script, you can compare them with AND or OR conditionals.
✯ The NOT conditional is not available.

AND
If a script contains two conditions, Condition 1 AND Condition 2 must be TRUE for the Action if True to be
executed.
Whenever a new condition is added to a script, the conditional AND is automatically applied. Unless
otherwise defined, in any list of scripted conditions, the conditions must all be TRUE for the action to fire.
✯ The AND conditional always has precedence over OR. In a list of scripted conditions, all of the

conditions joined by the default AND conditional are tested before any of the OR conditions.

OR
If a script contains two conditions connected by an OR conditional, Condition 1 OR Condition 2 must be
TRUE for the Action if True to be executed.
❍ To change a conditional to an OR condition, click OR. Use the MOVE UP and MOVE DOWN buttons to

reposition the OR condition. The conditions before the OR are compared to the conditions after it.
❍ To remove an OR conditional, click the Or line in the list of conditionals, and then click DELETE.

NOTE: When you delete an OR conditional, all of the conditions below the OR are deleted as
well. If you are going to use OR conditionals, be sure to check the logic of them before you
build the scripts.



66

TRIGGER AREAS
Trigger areas are created with the Polygon tool. When you create a polygon on the map, you can name it
and then reference it in scripts. They are very powerful elements of the scripting library.
It becomes apparent very quickly that you can create scripting systems that know everything about every
player on the map. However, testing many trigger areas simultaneously can slow down the frame rate. Also,
it is less realistic to have all-knowing armies. When using trigger areas, remember that the overarching goal is
to create a fun and lively experience that seems like real combat.

NOTE: Don’t have more than five overlapping trigger areas. The outer ones tend to get
forgotten.

✯ When creating trigger areas, be sure to give them descriptive names. For more information on creating
trigger areas, ➤ Polygon Tool on p. 26.

The following sections describe the key conditions for using trigger areas to test for the presence of teams,
individual units, and players.

TEAMS AND TRIGGER AREAS
✯ [Team] One Unit Enters an Area: Select the team name, Area name, and whether the team can enter

via ground, air, or both. You must select how the team enters. A player’s default team includes all of the
units on his side that have not been assigned to a team.

✯ [Team] One Unit Exits an Area: The assumption of this condition is that the team is already in the area,
so don’t activate scripts using this conditional unless you are sure that the team has already entered the
area.

✯ [Team] Team Completely Inside an Area: This script state becomes TRUE when all surviving members
of a team are inside an area. It is a good way to time events. For example, when all units are in an area,
you can launch an attack on them.

✯ [Team] Team Entirely Enters an Area: This script state becomes TRUE when all surviving members of a
team have at one point or another entered an area. Use it to pass between the beginning, middle, and
end of your mission, for example. A common technique is to change the map perimeter during various
stages of the game, and this condition can be used to assess when to change it.

✯ [Team] Team Entirely Exits an Area: This condition assumes that all surviving team members were in
the area at some time. Use it carefully.

✯ [Team] Team Has Units in an Area: The team has entered the area in some form. This condition is a
catch-all trigger test.

✯ [Team] Team Is Completely Outside an Area: The team has no presence at all in an area. This script is
useful for managing retreats or scripted exits of units from the map. You can also use it for checking
outer perimeter and inner perimeter breaching in Skirmish missions. For more information, ➤ A Few Extra
Steps for Skirmish Maps on p. 40.

UNITS AND TRIGGER AREAS
You can also perform some of the team tests on individual units. Note that these units must be given
specific names, so these tests are useful for examining the state of units that are placed on the map by the
designer—not units created by a player.
Some conditions available for teams are not available to test for individual units. To make those
comparisons, put the individual unit in its own team.
✯ [Unit] Unit Enters an Area: The named unit has crossed into a trigger area.
✯ [Unit] Unit Exits an Area: The named unit has left a trigger area.
✯ [Unit] Unit Inside an Area: The named unit is inside a trigger area.
✯ [Unit] Unit Outside an Area: The named unit is outside a trigger area.
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PLAYERS AND TRIGGER AREAS
You can also perform checks for the presence of a player’s army in a trigger area.
✯ [Skirmish] Player Has Units in an Area: The player has any number of units in an area.
✯ [Skirmish] Player Doesn’t Have Units in an Area: The player is completely outside of an area.
✯ [Player] Player Has Comparison Unit Type in an Area: The player has more than, less than, or equal to

the entered number of selected units in an area.
✯ [Player] Player Has Total Value in an Area: If the player has units and structures of value greater than

the value you define, action is taken. This condition is useful for timing attacks.
✯ [Player] Player Has Unit Type in an Area: This condition tests for the presence of a minimum number

of units of a selected type in an area. For example, you can script an AI attack on a player when 10
crusader tanks have been created. Use this condition to test for initial or large-scale attacks from the AI;
you don’t want the AI to overreact to small changes in a player’s army.

✯ [Player] Player Has Kind of Unit or Structure in an Area: This condition tests for the presence of a
minimum number of structures or units of a selected type in an area. For example, you can use it to
change strategies. If a player has created 5 Stinger sites, you might tell the AI to stop attacking with
helicopters and to use tanks instead.

SCRIPTING TUTORIAL
In the following section, you can read and learn how to script fundamental events in a scripted mission. The
materials covered here are just the basics, so be sure to test your scripts thoroughly.
✯ Keep it as simple as possible. No one cares if the AI made a right turn at a specific point. Avoid being

very specific. If your scripts are very specific, then re-examine your design goal. You could be setting up a
debugging nightmare for yourself.

✯ When developing for multiple difficulty settings, build either for the easiest or hardest difficulty setting.
Then, you can select or deselect scripts for the other difficulty settings.

HOW TO ACTIVATE THE SCRIPT DEBUGGER
World Builder includes a utility for debugging your scripts inside the game. For more information, ➤ Script
Debugger on p. 77.

HOW TO SET WIN CONDITIONS
You can tell a player that he has won the game at any time with any condition. When your chosen condition
has been met, the action to select is, [User] Announce quick win. The game is immediately over.
You may choose to take other script actions, such as destroying the remaining faction buildings, before you
announce the win.

HOW TO SET LOSS CONDITIONS
You can declare a player loss at any time with any condition. If the game is over for all players, use the
action, [Multiplayer] Announce Defeat. If the game has ended for only one player, use [Multiplayer]
Announce Local Defeat.
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HOW TO CREATE SUBROUTINES
A subroutine is a script that is accessed via another script. You do not perform a test to run a subroutine.
Instead, you call it from another script.
✯ When defined, subroutines are always active and can never be tested.
Subroutines are useful for optimizing your scripts, especially if you call actions multiple times under multiple
conditions. Through subroutines, you can create a generic set of actions that can be applied to multiple
teams. For example, you can use subroutines to instruct a team to hunt.
✯ Most AI orders are triggered through subroutines. When you are creating a team, the conditions that

you select under the Identity and Behavior tabs are subroutines only. These scripts are created as
subroutines, and the indicated condition is applied to them.

To define a subroutine:
1. Under Script Properties in the Script Builder window, check Script is Subroutine. Since subroutine scripts

are always active, deselect Deactivate upon success, which is not needed.
2. In almost all cases, leave the script condition to test empty (TRUE).
3. Define the action.
✯ Again, a subroutine cannot be enabled or disabled. So, be careful in using subroutines, which can run

and run over again.
To execute a subroutine:
1. To run the subroutine from another script, select a script action called, [Scripting] Script – Run.
2. Select the name of the subroutine from the drop-down.

HOW TO CREATE SEQUENTIAL SCRIPTS
A sequential script is configured to execute its sequence of actions one after the other. Typically, all actions
in a script are executed at the same time. In a sequential script, the first action is executed to completion,
followed by the next one, until all actions have been completed. Sequential scripts are useful for scripting
end-game sequences.
1. Create a standard script with the desired test conditions in place. Do not script any actions.
2. Build a subroutine that contains all of the actions to be taken in sequence.
3. For the first script, find and add the action [Team] Execute Script Sequentially - Start. Select the

subroutine that contains all of the sequential actions.
❍ To script the stoppage of a sequential script, use [Team] Execute Script Sequentially – Stop and select

the subroutine containing the scripted sequence.
❍ To loop a sequential script, use the action [Team] Execute Script Sequentially - Looping. Looping

sequences are useful for building railroads.

HOW TO SET DIFFICULTY LEVELS
In the Script Panel for each script, you can select or deselect whether the script applies to Normal, Hard, or
Brutal difficulty settings.
✯ If a difficulty setting is not selected, the script cannot run at all in that difficulty setting, even when it is

explicitly called.
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HOW TO SPAWN OBJECTS
You can add flavor to your maps by spawning objects that execute scripted actions to change the nature and
course of the mission. For example, you can script civilians to walk across the map, requiring your
protection.
✯ Be sure to spawn objects outside the map perimeter, as they appear out of thin air when spawned.
1. To spawn an object, use the action [Unit] Spawn – Object. Select the object and team to spawn.
❍ To spawn an object without assigning it to a team, select a player’s default team.
2. Enter the X, Y, and Z coordinates on the map where the unit should spawn.
✯ X, Y, and Z coordinates can be found in the status bar. If you do not specify a Z (height) coordinate, the

object is placed on the terrain. Do not place objects below ground.
3. Enter a figure for its angle of rotation. Object angles can be found in the Object Properties window for

each object.

SPAWNING UNNAMED UNITS
❍ To spawn an unnamed unit, use the action [Unit] Spawn - unnamed unit on a team at a waypoint. You

must specify the team to which it belongs and its starting waypoint.

SPAWNING NAMED UNITS
You can also spawn units that have defined names. Naming spawned units is useful for missions in which a
known event must occur at some point during the mission. You can write scripts for the named unit, spawn
the unit, and then execute the scripts accordingly.
1. To spawn a named unit, use the action [Unit] Spawn – named unit on a team at a waypoint.
2. Select the name of the unit from the drop-down list, or enter a name of a unit that has not been created.
3. Select the type of unit, and assign it to a team.
4. Select a waypoint where the unit spawns.
✯ After you define this particular script, the three question marks (???) in front of the listed action do not

necessarily indicate an error; they may indicate that this script is the first instance of the named entity.
Ignore them. Click OK, and your script may be fine.

HOW TO SCRIPT RE-INFORCEMENT TEAMS
Re-inforcement teams are a common tool in Command & Conquer Generals missions to keep the battle fresh. A
re-inforcement team is created off-screen and brought on-screen and into the battle, often via a transport.
Since these teams are created off-screen, they can be spawned, instead of accumulated in a base area.
✯ When you are learning to build re-inforcement teams, use air transports to bring them to their

destination, as by default, these teams take a straight-line path to the target waypoint. A straight path
can be problematic for a land-based team. It is more challenging to script a re-inforcement team to
follow a set of waypoints across the terrain.

1. Select EDIT TEAMS from the Edit menu.
2. In the Team Builder, select the player, and then click ADD NEW TEAM.
3. Define the team as needed.
4. Under the Reinforcement tab, check the box next to Deploy by. From the drop-down, select a transport

to bring the team onto the map.
✯ If you do not specify the Start team waypoint, then the waypoint specified in any script is the waypoint

where the team spawns.

NOTE: The game automatically creates enough transports to bring in the entire team. If you
want the team to be brought in one transport over multiple trips, you must create multiple
teams. Be sure to destroy each transport through scripts after it has completed its mission.

✯ If you do not check the Deploy by box, the team enters the map on their own.
5. Select a waypoint at which to spawn the team. Make sure that it is outside the map perimeter.
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6. If the team should spawn inside the transport, click the box next to Load members into transports.
7. In the Script Builder, build a subroutine to get the transport to move to a defined waypoint and to drop

the team.
8. In the Behavior tab of the Edit Team window, select the defined subroutine from the On Create drop-

down list.

HOW TO SPAWN TEAMS
✯ [Team] Spawn a reinforcement team: Use this action to spawn a reinforcement team that you have

defined. If no waypoint is specified in the Edit Teams window, then the waypoint defined here is where
the team appears.

HOW TO MOVE A TEAM TO A NEW LOCATION
One of the most commonly used actions is to move teams into new positions. It’s particularly important for
scripting attacks, as a good designer places units near to the target so that they are not distracted en route
and their inherent AI can manage attack functions.

MOVE TEAM ON A WAYPOINT PATH
✯ [Team] Set to follow a waypoint path: Use this action to tell a team of units to follow a named

waypoint path. Select the team and the waypoint path from the drop-down lists. If the team does not
travel as a team (FALSE), then each unit of the team travels the waypoint as an individual. Using this flag
on a branching waypoint path is an inexpensive way to create the appearance of flanking attacks. You
can also use it to add randomness to civilian behaviors.

MOVE TEAM ON A WAYPOINT PATH - EXACTLY
✯ [Team] Set to EXACTLY follow a waypoint path: Use this action to tell a team to follow a named

waypoint path exactly as it is laid out on the map. This action should be used only if you are creating
scripted cinematics and need units to behave in an exact manner. Units that follow a path exactly pass
through buildings and other objects without effect, so it is impractical for game actions.

MOVE TEAM ON A WAYPOINT PATH - WANDERING
✯ [Team] Set to follow a waypoint path - wander: Use this action to tell a team of units to follow a

named waypoint path in a wandering manner. Each unit of the team uses the waypoints as a general
guideline. Teams that wander tend to spread out more, which avoids traffic jams and looks more
natural. However, a unit of a wandering team can venture into territory that it should not, so use this
action carefully.

MOVE TEAM ON A WAYPOINT PATH - PANIC
✯ [Team] Set to follow a waypoint path - panic: For civilian use only. Use this action to tell a group of

civilians to move in panic along a named waypoint path. The civilians are displayed in their “panic”
animation state.

MOVE TEAM TO A WAYPOINT
✯ [Team] Set to move to a location: Use this action to move a named team to a defined waypoint. The

team takes whatever route it can find and is available. Sometimes, teams following this script action can
end up in unexpected places. However, it can be a useful means of gathering units from diverse sources.
In general, rally the team at a waypoint some distance from its current location and leave space around
the waypoint for units to cluster.

MOVE TEAM TOWARDS AN OBJECT OF A SPECIFIC TYPE
✯ [Team] Move team towards the nearest object of a specific type: This action allows you to direct a

named team towards the nearest object of a type. You can use it in combination with other scripts. For
example, when a team has finished moving along a set of waypoints, you can direct it to move towards
the nearest enemy tank. When this action finishes executing, the team should be able to attack. It’s
useful for scripting GLA commando-style attacks from Hijackers and Terrorists.

UNIT
All of the above script actions are available for individual units, except for Panic and Wander actions.
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HOW TO SCRIPT ACTIONS FOR AI TEAMS
When you create a new player, whether it is human- or CPU-controlled, a default team for the player is
created. The team name is “team” followed by the name of the Player. This team contains all units for the
player. You can script actions to apply to this team, which apply to all units for that player.

INITIAL ACTIONS
When a team is created for the AI, it’s a good idea to have a set of scripted actions for the team to follow.
Otherwise, it sits in the base area, doing nothing. A good structure for a team’s initial action is to send it
along a waypoint path to get it closer to combat. When the team reaches the end of the waypoint path, you
can assign it to move towards the nearest enemy vehicle, guard, or hunt through scripts. If the team is
scripted to attack a specific target and succeeds, its final action should be to hunt enemy units. Otherwise,
the team sits, doing nothing. For more information on sequential scripts, ➤ How to Create Sequential Scripts on
p. 68.
✯ You can create basic responsiveness of the AI by setting the Aggressiveness of each team in the Behavior

tab of the Edit Team window.

AI ATTACK TEAMS
An attack team for an AI player should consist of two or so attack teams. For easier difficulty settings, you
may consider sending only one attack team. A high number of teams in an attack is hard to defend and
hard for the designer to manage. Keep it simple, if possible.
You can establish priorities for your attack teams by setting attack priorities (➤ How to Configure and Execute
Attack Priorities for the AI on p. 72) for object lists (➤ How to Create Object Lists below), or by sequential
scripting (➤ How to Create Sequential Scripts on p. 68) for specific targets.

AI DEFENSIVE TEAMS
Following the principle of having three entrances to each base, an AI army should have three defensive teams
or one for each entrance to its base.
Defensive teams for the AI can be set to varying levels of responsiveness. You can tell a unit to simply guard
an area, changing the Aggressiveness setting to a low level. Or, you can have one fast defensive team that is
responsible for attacking anything that breaches perimeters that you define with the Polygon Tool (➤ p. 26).
✯ The condition, [Skirmish] Player has discovered another player, can be used to switch the AI into a

different defensive posture.

NOTE: Be sure to create a subroutine to be called when the situation is all clear for a defensive
team. This script should tell the units to resume their original behaviors. You select the On All
Clear subroutine in the Edit Teams window. For more information, ➤ Edit Teams on p. 17.

HOW TO CREATE OBJECT LISTS
Object lists are sets of multiple choices of objects that the AI can use to establish a valid target. Anywhere in
the Script Builder that you can specify a type of object, you can use an object list. When you do so, the
available object lists are listed below the types of objects.
✯ [Scripting] Object Type List – Add Object Type: Use this action to create new object lists and add

objects to existing ones. To create a new object list, enter a name in the drop-down. Then, select an
object to add.

✯ [Scripting] Object Type List – Remove Object Type: Use this action to remove object types from an
object list. This action is useful for re-assigning priorities if an enemy’s capabilities have been destroyed.



72

HOW TO CONFIGURE AND EXECUTE PRIORITY LISTS
FOR THE AI
A priority list can be applied to a team or unit to rank the importance of destroying targets. Items with a
higher priority are always targeted first, even if there are targets of opportunity in the vicinity. You can use
priority lists to create better strategies for base attack, base defense, reconnaissance, anti-tank, and anti-air.
1. Use the action, [Attack Priority Set] Set modify priorities for all of a kind.
2. Give the priority set a name.
3. Select the type of element from the drop-down list.
4. Enter an integer for the priority. The default value is 1, while object types with a value of 0 are never

attacked. Higher values have greater priority. You define the scale yourself.
5. To create a priority for another type of object, copy the priority action. Do steps 3 – 4 for the new object

type. For the new object type, you can enter a different number for the priority to rank the desirability of
the targets.

ATTACK PRIORITIES FOR A SINGLE UNIT TYPE
✯ [Unit] Modify priority set for a single unit type: You can modify an existing priority set for a single type

of unit. Use this action for a more fine-tuned list. It’s also useful for special-purpose units like the
Hijacker, Black Lotus, and Colonel Burton.

ATTACK PRIORITIES FOR A TEAM OR UNIT
✯ [Unit] Apply a team’s attack priority set: Use this action to apply a defined attack priority set to a

named team. Specify the team and the priority set to use.

ATTACK DEFAULT PRIORITIES
✯ [Attack Priority Set] Set the default priority: Use this action to reset the default priorities for a priority

list to a specified number. You can use this action to essentially overwrite all of the priorities in that list.

HOW TO GET THE AI TO ATTACK
You can use scripts to define specific attacks against other players. Attack scripts can be applied to
individual units, teams, or every unit in a player’s army. Use the following actions to get units on the attack.

AI TEAM ATTACKS
✯ [Team] Set to hunt: Select the team to begin hunting. In hunt mode, teams scout for enemies and

attack them when they are discovered. Hunt mode can be superseded by priority lists.
✯ [Team] Set to attack – another team: Select the team that is attacking. Then, choose the team to be

attacked.
✯ [Team] Set to attack – specific unit: Select the team that is attacking. Then, choose the named unit,

such as Colonel Burton, to attack.
✯ [Team] Set to attack – trigger area: Select the team that is attacking. Then, choose the trigger area to

attack. The team moves to the trigger area and attacks any enemy units or structures in the trigger area.
✯ [Team] Set to attack – trigger area: Select the team that is attacking. Then, choose the trigger area to

attack. The team moves to the trigger area and attacks any enemy units or structures in the trigger area.
✯ [Team] Set the general attitude of a team: Select the team. From the drop-down list, select a new

behavior. These options match those available in the Initial Team Behavior drop-down in the Behavior
tab of the Edit Team window. For more information, ➤ Edit Teams on p. 17.

AI UNIT ATTACKS
All of the above actions can be applied to units, too.

AI PLAYER ATTACKS
You can put an entire army in motion. While these all-or-nothing scenarios can be exciting in concept, they
can ruin the frame rate if the army is large. However, in dire circumstances for the player, user it.
✯ [Player] Set all of a player’s units to hunt: Any available unit of a player begins hunting for enemies.
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HOW TO CONFIGURE THE AVAILABLE TECHNOLOGY
TREE
In the single-player campaigns, you may have noticed that the entire technology tree may not be available on
some missions. Through scripts, you can make specific structures, units, or abilities unavailable.
Additionally, you can define the beginning and limiting rank for a mission, which limits the Generals Abilities
available to players.

MAKING SPECIFIC OBJECTS UNAVAILABLE
✯ [Map] Adjust the tech tree for a specific object type: Select the object in the drop-down list. Then,

select the availability of the object. IGNORE_PREREQUISITES means that the object is immediately
available at the beginning of the mission, no matter where it is located in the standard technology tree.
ONLY BY AI prevents human players from building the object.

MAKING SPECIFIC OBJECT ABILITIES UNAVAILABLE
✯ [Scripting] Remove a commandbutton from an object type: You can use this script to remove a specific

power from a specific object type. For example, in your map, you may want the American Ranger to be
unable to capture buildings. If you reference a CommandButton that does not exist for the selected
object type, the results are unpredictable. Use and test this script carefully.

SETTING PLAYER RANK LEVELS
✯ [Map] Set Rank Level Limit for current Map: This script action limits the number of Generals stars that

a player can achieve on the map. Set the rank from 1 to 5.
✯ [Player] Set Rank Level: Set the starting rank level from 1 to 5 for the selected player.

HOW TO CHANGE THE MAP SIZE DURING A MISSION
In some of the single-player missions, the player appears to open new parts of the map by completing
objectives in the game. You can do the same thing in your maps by changing the map boundaries through
scripted events.

CREATING MAP BOUNDARIES
When you create a new map, the default map perimeter is displayed as an orange rectangle around the
perimeter. You can adjust this perimeter or create up to eight additional ones. For more information, ➤ How
to Build a Map Perimeter on p. 54.

CHANGING THE ACTIVE MAP BOUNDARY
Through scripts, you can designate which of your created map perimeters is active.
✯ [Map] Change the active boundary: Use this action to change the active perimeter. From the drop-

down, select the color of the map perimeter that you are now activating.

WARNINGS:
✯ If your map size must change during the mission, start with a smaller-sized map using the orange default

map perimeter first. Then, grow the size of the map over the course of the mission. Shrinking the map
can cause problems.

✯ If you peel back the entire shroud through scripts and then change the borders, the new border’s shroud
may still be partially obscured.
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HOW TO TRIGGER AUDIO
You can use the conditions and actions in the Multimedia section of the Script Builder’s lists to manage the
audio in your map. The following conditions and actions are useful.

PLAYING SOUND
✯ [Multimedia] Play a speech file: Use this action to play back a speech file. Select a speech file from the

drop-down list. To hear a preview, click PREVIEW SOUND. You can select whether to allow sound
overlap. If it is set to FALSE, all other scripted audio gets turned off as it plays. You can use that flag to
ensure that mission-critical voice-over is heard by the user.

NOTE: Never rely on speech to be the exclusive means by which players hear critical
information. Always back up any mission-critical audio with text messages on the screen.

SETTING AUDIO VOLUME
✯ [Multimedia] Set the current sound volume: This action sets the basic sound volume. It can be

overridden by other scripted actions.
✯ [Multimedia] Sound Events - Override volume – type: Use this action to play back a selected sound at

a selected volume. You can set volumes to be greater than 100%.
✯ [Multimedia] Sound Events - reset volume - all: This action restores the volume of all sound types to

their default levels.
✯ [Multimedia] Sound Events - reset volume - type: This action restores the volume of a specified sound

type to its default levels.
✯ [Multimedia] Sound Events - disable type: Disables playback of a specified sound type.
✯ [Multimedia] Pause the ambient sounds: This action pauses the playback of ambient sound, which is

useful if the user needs to hear very important audio.

SETTING AUDIO CONDITIONS
The triggering of audio is often based on user action or a timer. You can test whether audio has finished
playback to execute scripts with the following conditions.
✯ [Multimedia] Speech has completed playing: This condition tests whether a specified speech file has

completed playback.
✯ [Multimedia] Sound has completed playing: This condition tests whether a specified sound file has

completed playback.
✯ [Multimedia] Music Track has completed some number of times: Use this condition to test whether a

specified music track has played a specified number of times. Use this condition only for triggering
another piece of music.
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DEBUGGING
During the course of developing a map, you may discover problems with it. Textures can get blended poorly,
objects can get misplaced, scripts can acquire bugs, and designers can get confused. The following chapter
offers some basic suggestions for how to debug problems with your maps and their scripts.

DEBUGGING OBJECTS

SELECTING DUPLICATE OBJECTS
When you copy an object and then paste it, the new object is pasted on top of the original one. Looking at
the two objects, you see one image. If you forget about the object, you can end up with duplicate objects.
Use this command to select objects on top of each other. It selects the top instance of every object that has
a duplicate on the map. From time to time, you should select duplicate objects to locate these errors.
❍ To select duplicate objects in your map, choose SELECT DUPLICATE OBJECTS from the Edit menu.

FINDING LOST OBJECTS
Have you misplaced an object? If so, you can use the Select Similar tool to select items of the same class. When
a building is selected, for example, apply the Select Similar tool to select each building on the map. You can use
this tool to select for all types across the entire map. For more information, ➤ Select Similar on p. 16.
❍ If you have a mouse wheel, you can use it to rotate the camera to other perspectives, which may reveal

smaller objects hidden behind larger one.
Additionally, you can scan through the Layers List to search for the missing item.
✯ To reveal each layer in the Layers List, right-click on the icon next to the layer. Then, deselect HIDE

CURRENT LAYER. Check the map to see if the missing object is revealed.

FIXING TEAMS
If you delete a player from the Player List for your map, any units or structures that were assigned to the
player now have invalid associations. They belong to no team.
You can fix teams in two ways:
❍ To let the application fix teams as best as it can, select FIX TEAMS from the Validation menu.
When the application fixes teams, it assigns unaligned units and structures to the remaining teams in the
map. However, if a Chinese MiG airfield is assigned to the GLA, for example, then the GLA side now has air
power, which could reshape the balance of power in the map. It’s much better to try to identify unaligned
units and structures and then to manually assign them to teams.
❍ To manually assign units to team, choose SELECT BAD TEAM OBJECTS from the Edit menu. All objects

that have invalid team assignments are selected. You can then fix them manually.
❍ To fix a unit’s team, select the unit. In the Object Properties window, select a new team from the drop-

down list. The unit has been re-assigned.
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REPAIRING TEXTURE ERRORS
To produce good texturing requires plenty of design work in World Builder and lots of computation by the
application. During development, you may see bad blends between textures, or you may accidentally create
the computationally intensive three-way blends.

HARD TEXTURE EDGES
While painting textures, you can create hard edges to your texture fields and need to soften them with
blending. Instead of blending the whole texture field outward, you can blend a single edge inward.
1. To blend a single edge, select the Blend Single Edge tool in the toolbar.
2. Place the cursor just outside the hard edge. Click and drag across the border into the other texture.

Release the mouse button.
3. The edge is softened.

BLENDS IN THE MIDDLE OF A TEXTURE FIELD
If you discover an accidental dab of incorrect texture in a field of color, you can remove it easily.
1. Click the Eyedropper tool in the toolbar.
2. Click the texture to paint over the incorrect texture.
3. Click the Single Tile or Large Tile tool in the toolbar.
4. Paint over the incorrect texture with the correct texture.
5. Blend the texture as needed.

THREE-WAY BLENDS
When three fields of texture are blended together, you can create three-way blended textures. While these
are not errors in the strictest sense, you do want to limit the number of three-way blends in your map.

✯ A good rule of thumb is to keep the number of three-way blends to less than 300 in a map and no more
than 50 in any area displayed on the screen.

1. To show the three-way blends in your map, select SHOW 3-WAY BLENDS IN WHITE. The three-way
blends appear as white tiles on your map.

2. Use the Eyedropper tool to select one of the textures contained in a three-way blend.
3. Select the Single Tile or Large Tile tool in the toolbar. Paint over the area.
4. Use the Auto Edge Out or Blend Single Edge tools to blend from one texture to another.
5. If another three-way blend is created, it is displayed in white. The process can be repeated.

NOTE: There is no easy way to reduce three-way blends. When in doubt, start over and reduce
the amount of overlapping textures. That method often produces better results.

Three-way blended
texture area
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STRETCHED CLIFF TEXTURES
When textures are stretched over cliffsides, the effects can be grotesque. You can try these three approaches
to get a better effect:
1. Smooth Height tool. In the toolbar, select the Smooth Height tool. After setting the options for the tool,

click and drag all over the cliffside to scrub out the roughness on the cliffside. Turn up the Feather Rate
to its highest setting. For more information, ➤ Smooth Height on p. 23.

2. Map Cliff Textures. If the Smooth Height tool fails to produce the desired results, select MAP CLIFF
TEXTURES from the Texture Sizing menu. Then, click the bad-looking textures. How do they look? If
there is a black band at the top or bottom of the texture field, apply textures to those areas and blend
them.

❍ To undo the cliff texture mapping, press v + Z.
3. Reshape the Cliff. If mapping cliff textures fails to work, you should reshape the face of the cliff. Instead

of a single long face, make the cliff multiple shorter and slighter grades.

SCRIPT DEBUGGER
NOTE: The Script Debugger may not be available in your version of the game.

One of the more useful tools in World Builder is accessed outside of it. The Script Debugger allows you to see
the real-time progress of your variables, counters, flags, and timers as you play your designs inside the game.
It is an invaluable resource to the process of completing quality maps.
✯ If your computer is good enough to do so, you can open World Builder and the game at the same time.

Such an arrangement allows you to jump back and forth between design and debugging tasks. World
Builder supports dual monitor usage.

ACTIVATING THE SCRIPT DEBUGGER
1. Exit World Builder.
2. Navigate your local computer to the Command & Conquer Generals directory.
3. Create a shortcut for GENERALS.EXE. To create a shortcut, right-click GENERALS.EXE and select

CREATE SHORTCUT. The shortcut is created in the directory.
4. Cut and paste the shortcut to the desktop.
5. Right-click on the shortcut.
6. Create shortcut to GENERALS.EXE.
7. Under the Shortcut tab, select the Target text field. Add “ –win –scriptdebug” to the end of it, outside

the quote mark. These switches tell the game application to activate the Script Debugger.
8. When you are designing and debugging maps with scripts, double-click this shortcut to open the game.

The Script Debugger opens with it.

SCRIPT DEBUGGER SCREEN
When you open the game with the Script Debugger activated, the Script Debugger screen is displayed over
the game screen.
✯ Frame. A counter indicating the current frame of the game session. After a map is started, this counter

does not reset.
✯ Variables. In the Variables pane, you can review the current state of all of your scripted boolean flags,

timers, and counters.
✯ Messages. The Messages pane lists all of the scripts that have been fired and some other messages from

the AI. The left-hand number of a message indicates the frame in which the event was fired.
❍ To pause the game momentarily, click PAUSE.
❍ To step through the game frame-by-frame, click PAUSE, and then click STEP. Continue clicking STEP to

step additional frames.
❍ To step in 10-step frame jumps, click RUN FAST 10X.
❍ To remove all of the messages from the Variables and Messages panes, click CLEAR.
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OPTIMIZING YOUR MAP
As you build your map, it’s important to optimize periodically. It’s very easy to use the tools of World Builder
to create maps that play too slowly on even good machines. When the frame rate for the game gets too low,
the gaming experience is degraded. From time to time, you should perform these tasks to optimize your
maps for good performance on all platforms.
✯ If you’re having problems with performance in World Builder, consult the suggestions at the end of this

section.

ELEMENTS TO OPTIMIZE

OBJECT COUNTS
✯ The number of objects on your map is displayed on the far left side of the status bar at the bottom of

the screen.
✯ Limit the number of objects you use. A good limit is 100 objects per player in multiplayer maps. If you

have two players on the map, you can increase this limit somewhat, as there are many players creating
objects on the map.

✯ In single player, 1,800 total objects is the recommended limit.
✯ Be careful when creating cities and forests with high object counts. Remember that you are creating a

battleground with the impression of a city or a forest; you are not creating the city or forest itself. You
need fewer objects to create a simple impression. For example, you can create the impression of a forest
with no more than 40 trees. Practice to see what you can get away with, and remember that the quality
of the gameplay is always the overriding factor.

STEEP SLOPES
✯ Don’t build unnecessarily steep slopes. Units cannot target up a steep slope. To see which slopes are

steep, select SHOW IMPASSABLE AREAS and then select IMPASSABLE AREA OPTIONS from the View
menu. In the dialog, enter the maximum angle that is acceptable and click OK. You can now see
impassable areas in your map. Use the Smooth Height tool to smooth them down.

✯ Remember to reset the Impassable Area option to 45 degrees.
✯ Before you release your map, use the Smooth Height tool on all of the cliffs and across all of the flat

areas. Use it to smooth as much as possible. Don’t be afraid to turn up the Feather Rate to its highest
setting. Lots of smoothing makes your map look nicer and perform better.

BLENDED TEXTURES
✯ You must blend textures to create more natural effects, but do not blend textures unnecessarily. There is

always a resource hit on blending textures.
✯ Three-way blended textures are resource hogs. Limit yourself to no more than 300 three-way blended

textures in your map. Fewer such blends make for better game performance.
✯ There should never be more than 50 three-way blends in a single shot of your map from the standard

camera position.
✯ When in doubt, start over painting textures, and try to avoid overlaps.
✯ For information on reducing the number of three-way blends, ➤ Three-Way Blends on p. 76.
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MAP SIZE
✯ If your map has grown to larger than 400 x 400 tiles, you should consider reducing the open space

between areas of your map. Alternatively, you can save two copies of the map and continue developing
two separate maps.

✯ There is a script available called, “Oversize Terrain.” Do not use it. Used mostly for cinematic sequences,
the script allows the camera to display a larger area of the map during pans and tilts. However, it is a
huge hit on the frame rate and is not worth the cost. In the single-player campaigns, the script is no
longer used.

MAP PERIMETER
✯ Before you release your map, check the map perimeter. Click the Border tool in the toolbar. The orange

border marks the play area, and the blue border marks the edge of the workspace. If they do not match,
players may not be able to access all of your map. However, if you change map borders during the
course of the mission, this caution may not apply.

TRIGGER AREA POLYGONS
✯ Don’t have more than five overlapping polygons. The outer ones tend to get forgotten.

SUFFICIENT SPACE
✯ Avoid creating choke points. Too many choke points slows the game, turns it into a slugfest, and kills the

frame rate. Open maps are better in most cases.
✯ If you are creating a choke point, it should be wider than the length of five tanks at a minimum.
✯ Even in urban settings, create as much space as possible. Extremely narrow spaces between buildings can

cause pathfinding problems for the units. If the group is sufficiently large, the units in the rear tend to
twitch as they search for various paths. It slows the game down. Open up your maps where possible.

OBJECT PLACEMENT
✯ Avoid overlapping objects. While you can sometimes produce interesting visual effects, these screen

elements are interactive objects that can result in some strange behaviors in the game.
✯ Did you raise your terrain recently? Some objects may be buried now. Use the Pick Similar command or

the Layers List to find missing objects.
✯ Roads, as objects, are different from regular objects. You can overlap roads of the same type to create

intersections, but you cannot overlap dissimilar roads. For more information, ➤ How to Build a Road on p. 49.
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BODIES OF WATER
✯ Use the default water polygon as much as possible. If you consider the water polygon as sea level in your

map, you can use it to build multiple lakes and even the border of the ocean.
✯ Never overlap water polygons. It drastically increases the number of control points. Instead, create a

single, more elaborate water polygon.

RESOURCE COUNTS
✯ There should be $40,000 – $60,000 of resources per player on the screen.
✯ Limit the number of units that generate resources on your map. Oil derricks are continual sources of

funds. Too many of them can turn each game played on your map into a slugfest.

WAYPOINT PATHS
✯ Avoid having S-turns in your waypoint paths. They should be straight lines, simple turns, or at most, arcs

to their target.

SCRIPT MANAGEMENT
✯ Use the Script Debugger to track your scripts during a mission. For more information, ➤ Script Debugger

on p. 77.
✯ Don’t activate a script and check its condition unless it is necessary. Enable scripts only when they are

needed. Scripts that check to see if units should take actions such as move, attack, or guard are
expensive to check. So are trigger areas. They can cause a reduction in frame rate.

✯ If you are giving out attack or move commands, don’t give them all out in a single frame. Dispense
orders over a sequence of frames.

✯ Similarly, spread out the spawning, destruction, and deletion of objects over time. When a unit is
spawned, its AI immediately begins working, which impacts the game. Space these events out.

SELECT OBJECTS
✯ A good checkup before you publish a map is to check each type of object to make sure that every

instance is accounted for and intended to be part of your map. Use the Select Similar tool to select
objects of the same type.

✯ Prior to release, use the Select Duplicate tool to check to see if you’ve accidentally placed objects on top
of each other, which is an artifact of the copy and paste functions.
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IMPROVING PERFORMANCE IN
WORLD BUILDER
World Builder is a high-performance application that makes significant demands on your system’s resources.
If you are experiencing slow-downs in screen updating, try the following to improve performance of World
Builder.
✯ Reduce the amount of map displayed on-screen. World Builder slows down if the display area is too

large. Under the View menu, select VIEW PARTIAL MAP SIZE. Choose a smaller size of map to display.
✯ Close all other applications. While World Builder can work while other applications including the game

are open, it works better if all others are closed.
✯ Display only what needs to be displayed. Use the View toggles to hide elements of the map that are not

germane to your current task. For more information, ➤ View Menu on p. 18.
✯ Turn OFF object shadows. The shadowing of objects can significantly impact the performance of World

Builder. To turn off shadows, deselect SHOW SHADOWS in the View menu.
✯ Turn OFF display of clouds. Similarly, clouds can significantly impact the performance of World Builder.

To turn off cloud display, deselect SHOW CLOUDS in the View menu.
✯ Get acquainted with layers. You can organize objects in your map into layers whose display can be

toggled. For more information, ➤ Layers List on p. 27.
✯ Lower window resolution. If you set the window resolution too high, you may experience slow-downs in

performance. Try lowering the window resolution through the Window menu. If the Work window
becomes too small on the screen, set the screen resolution through the Windows control panel. For
more information, see your Windows documentation.

✯ Use the default water plane. Each map comes with one default water shape that has much less impact
on performance then any custom water shapes. For more information, ➤ Water Tool on p. 23.

✯ Avoid soft water display. When displaying soft water, you soften the edges between water shapes and
the land that surrounds them. While this effect is much more pleasing to the eye, it slows down World
Builder. To toggle display of soft water, select SHOW SOFT WATER in the View menu.

✯ Use default object shadows. While customizing shadows for individual objects can produce some nice
effects, there are more important design tasks. Additionally, it can slow down your speed in completing
those more important ones. Use customized object shadows sparingly.

✯ Check the amount of map displayed on-screen. Are you displaying the entire map? To toggle display of
the entire map, select SHOW ALL OF 3D MAP from the View menu.

✯ Watch your object counts. As a general rule, keep the number of objects below 100 per player in
multiplayer/Skirmish maps and 1,800 total objects for single-player mission maps. Object counts can
impact performance in World Builder and the game.

✯ Toggle OFF display of the macrotexture. To toggle display of the macrotexture, select SHOW
MACROTEXTURE from the View menu.
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GLOSSARY
Term Definition  
3D Wireframe The underlying mesh that describes the shape of the terrain. To see the

3D wireframe, select SHOW WIREFRAME 3D VIEW from the View
menu.  

Ambient Sound Ambient sounds can be placed on your map to create a nice sense of
environment.   

Auto Edge Out tool The Auto Edge Out tool blends a selected texture outward into the
surrounding textures, creating new blended textures between them.  

Blend Single Edge Painting with textures often leaves the sharp edges of the tiles on your
map. You can smooth individual edges using the Blend Single Edge tool.
For more information, ➤ Blend Single Edge on p. 24.  

Build List tool For CPU-controlled players, a Build List indicates the order in which its
structures should be created. For more information, ➤ Build List on p. 59.  

Camera The position of the camera over the terrain can be manipulated with the
mouse. For more information, ➤ Camera Settings on p. 11.  

Cliff Textures Due to the sharp change in elevation, cliffs can cause stretching of the
textures that looks unnatural. World Builder can assist in the placement
of cliff textures. For more information, ➤ Map Cliff Textures on p. 20.  

Dig tool Use the Dig tool to remove terrain and dig valleys, riverbeds, and
canyons in the map. To remove terrain, select the Dig tool from the
toolbar.  

Global Lighting Using global lighting options, you can set the overall lighting for the
map and can vary the lighting for objects and structures. For more
information, ➤ Global Lighting on p. 9.  

Grid A square grid can be displayed over your map to assist in measuring
distances and aligning the placement of objects. To toggle display of the
grid, select SHOW GRID from the View menu.  

Grove tool The Grove tool can be used to place natural-looking collections of trees
of different types. For more information, ➤ How to Build a Grove on p. 52.  

Impassable Area When the terrain is too steep, vehicles cannot pass directly over it. To
toggle display of the impassable areas of your terrain, select SHOW
IMPASSABLE AREAS from the View menu. You can also paint
impassable textures onto your map. For more information, ➤ How to
Paint Passable and Impassable Terrain on p. 46.   

Impassable Area Options You can set the angle at which a slope becomes impassable to ground
units. To set the angle, select IMPASSABLE AREA OPTIONS from the
View menu.  

Layer A layer is a collection of objects on a map whose display can be toggled
through the Layers List.  

Layers List Through the Layers List, you can organize objects into layers whose
display in World Builder can be toggled to simplify your view. For more
information, ➤ Layers List on p. 27.  

Macrotexture The macrotexture is the default background texture on your map. When
you first create a map, the macrotexture is displayed over its entirety.   

Map Perimeter Around the edge of the map, you must define its perimeter for 
AI-controlled units. For more information, ➤ Border Tool on p. 26.  
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Mesh Mold tool The Mesh Mold tool can be used to add pre-formed shapes to the
terrain. For more information, ➤ Mesh Mold Tool on p. 23.  

Mound tool Use the Mound tool to raise the elevation of the terrain under the
cursor. For more information, ➤ Mound Tool on p. 23.   

Object An object is a structure, vehicle, sound, or other element that you place
on your map. Depending on the type of object, other parameters and
behaviors must be defined as well.  

Object count In the lower-left corner of the Status Bar, the number of objects in the
map is displayed. Try to keep below 100 objects per player in
multiplayer maps and 1,800 objects for single-player maps.   

Object Library Through the Object Library, you can find and place objects on your
map.   

Object Properties Associated with each object is a set of properties that describe its side,
health, visual appearance, and behaviors. When the object is selected,
these properties are displayed in the Object Properties window. For
more information, ➤ Object Properties on p. 28.  

Pick Constraint To select a type of object on the map, use the Pick Constraint tool. For
more information, ➤ Pick Constraint on p. 17.  

Player A Player is any human- or CPU-controlled army on the map. Each
player must defined through the Player List. For more information, 
➤ Player List on p. 55.  

Player List tool The Player List tool lets you define the players in the game. For more
information, ➤ Player List on p. 55.  

Polygon tool Using the Polygon tool, you can define trigger areas that can be
referenced in scripts. For more information, ➤ Polygon Tool on p. 26.  

Ramp tool The Ramp tool lets you build ramps in the terrain. For more
information, ➤ How to Build a Ramp on p. 43.  

Road tool Use the Road tool to create roads, sidewalks, and railroads. For more
information, ➤ How to Build a Road on p. 49.  

Scripts Using scripts, you can generate actions based on events that occur
during gameplay. For more information, ➤ Scripts on p. 61.  

Shadows You can create shadowing effects that are different from those implied
by the global lighting settings. For more information, ➤ Edit Shadows on
p. 17.  

Smooth Height tool The Smooth Height tool lets you smooth the roughness out of shaped
terrain. For more information, ➤ Smooth Height on p. 23.  

Status Bar At the bottom of the screen, the Status Bar displays important
information on object counts, waypoint counts, and cursor position.
For more information, ➤ Status Bar on p. 27.  

Team A team is a collection of one or more units that can be controlled as a
single entity. Users can create teams in the game, and designers can
create teams for CPU-controlled sides. For more information, ➤ Building
Teams on p. 56.  

Terrain Terrain is the general term used to describe the land forms of your map.
Using the tools of World Builder, you can add, remove, smooth, and
shape the terrain.  

Terrain Brush Options When using the terrain tools, you can configure the size and effects of
the brush used to shape the terrain. For more information, ➤ Terrain
Tools on p. 22.  



84

Texture A texture is a two-dimensional graphic image that is laid across the
terrain to give the appearance of a land form. For example, textures can
look like grass, mountain, sidewalk, or road.  

Three-Way Blends When the Auto Edge Out tool is used to blend more than two textures
together, three-way blends can occur. Three-way blends can significantly
slow down the game. To see the three-way blends in a map, select
SHOW 3-WAY BLENDS IN WHITE from the View menu.  

Time of Day You can set the time of day on your map. For more information, 
➤ Change Time of Day on p. 19.  

Toolbar Across the top of the screen, the toolbar contains a set of icons that,
when pressed, activate map tools.  

Trigger Area A trigger area is an area of the map that you define and name. The
trigger area can then be referenced in scripts. For example, when a unit
enters an area, a scripted action can be taken. For more information, 
➤ Polygon Tool on p. 26.  

Unit An individual infantry, vehicle, or airborne unit. A unit is the
fundamental piece of an army.  

Water Plane Appearing as a blue rectangle in a newly created map, the water plane
can be used to define large bodies of water in your map. For more
information, ➤ Water Tool on p. 23.  

Water tool The Water tool allows you to create rivers or lakes. For more
information, ➤ Water Tool on p. 23.  

Waypoint A waypoint is a location on a map. Units can be ordered to move to a
waypoint or through a sequence of them.  

Waypoint count In the Status Bar at the bottom of the screen, the total number of
waypoints used in the map is displayed. For more information, ➤ Status
Bar on p. 27.  

Waypoint path A sequence of waypoints on the map, which can be accessed through
scripts. Units can be ordered to follow a waypoint path to complete a
scripted task.  

Waypoint tool Using the Waypoint tool, you can define sets of waypoints for units to
follow. For more information, ➤ Waypoint Tool on p. 26. 
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APPENDIX A: A GOOD
INITIAL SKETCH
The enclosed drawing is the original concept sketch for the Skirmish map titled, “Alpine Assault.” In the
drawing, you can see how closely it compares to the final produced map. Additionally, the artist has
indicated where passable slopes are located. One suggested improvement to this drawing would be to
differentiate between supply depots and oil derricks, which are technically limitless.
You might want to print out this page and compare it to the map in the game. In the final design, the
designer did a good job of freeing up more space in the middle by moving the railroad to the left and
cutting back significantly on the number of trees. Also, the number of supply depots was cut for both sides,
and the railway station was removed.
✯ Original Alpine Assault concept sketch by Ejah.
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Noticed from a screenshot by
the editor at a games Web site
that there are railway tracks.
And since I’ve been to
Switzerland before I still
remember these villages with
their small train stations.

Start locations are in the
woods, with a small village
nearby, split by a railway track.

The village is located in a valley
surrounded by smaller and one
large mountain range.

At the top of the biggest
mountain there is the snow
boundary (not sure if this is
the right word for it).
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NOTICE
Electronic Arts reserves the right to make improvements in the product described in this manual at any time
and without notice.
This manual and the software described in this manual are copyrighted. All rights are reserved. No part of
this manual or the described software may be copied, reproduced, translated, or reduced to any electronic
medium or machine-readable form without the prior written consent of Electronic Arts.
Software and Documentation © 2003 Electronic Arts Inc. Electronic Arts, and Command & Conquer are
trademarks or registered trademarks of Electronic Arts Inc. in the U.S. and/or other countries. All Rights
Reserved.  All other trademarks are the property of their respective owners.  
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